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Chapter 1 Introduction

What is Shorthand?

Shorthand is aword expander and keyboard simulation program that lets you define
abbreviations or keywords to play back previoudly stored words, phrases and even large
blocks of text. This reduces keystrokes and increases your typing speed.

Shorthand works with ailmost all Windows applications that run with the Windows™
desktop operating system (Windows 95/98/Me/2000/X P/Server 2003) and will replace
your abbreviations as you type. For example, let's say you defined an abbreviation in
Shorthand called asap to represent the phraseas soon as possi bl e. Whenever you
type asap , asmall, yellow Shorthand Hint Window will pop up with the suggested text.

W Microsoft Word X

|£| B - . .

-

We need the project done asap|

Shorthand Hint

Window ——p» asap
as soon as possible

The full text (*as soon as possible”) isinserted after the space bar, any punctuation mark
or the key ispressed. You can assign akeyword to represent words, phrases, and
sentences. Shorthand also supports dynamic text (i.e. text that can be changed
interactively) through Shorthand Tag codes (p. 65). With embedded Shorthand Tag
codes, you can tell Shorthand to pause to accept input from the user, insert the current
date, synthesize keystrokes, launch other programs or perform mathematical
computations.

The number of entries and Shorthand dictionary filesis only limited by the size of your
hard disk space.

Copyright © 2002-2005 by OfficeSoft LLC (http://pcshorthand.com). It is illegal to copy any portion of this book.
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Installing Shorthand
This book assumes you have Shorthand Version 9.00c or later.
Install Shorthand by running SETUP.EXE from the Shorthand CD.
For the latest version of Shorthand, visit

htt p: // ww. pcshort hand. com

How to use Shorthand

1. Start the Shorthand program (p. 13). If you have atrial license, the About box
appears showing the number of days remaining; click OK to continue.

2. Access the Shorthand Main Window by pressing F10 or clicking on the Shorthand
system tray icon (p. 13).

3. Openadictionary (p. 20). For this example, let's open the DEMO1 dictionary by
clicking on the Dictionary tab at the bottom of the Shorthand Main Window |abeled
"DEMOL1" (if thereis no DEMOL1 tab, choose Open from the File menu and select
DEMOL.SPF).

4. Click on the HIDE button (p. 16). The Shorthand Main Window disappears and
Shorthand monitors your keystrokes as you type.

Run your word processor and open a new document.

In your word processor start typing normally; Shorthand will replace abbreviations
asyoutype. For example, if you type:

asap (]

Shorthand should insert as soon as possi bl e in your document. (If nothing
happens, see p. 129 for troubleshooting tips.)

Tutorials

To get a better idea of how Shorthand works, we suggest you go through the tutorials
that come with the Shorthand program. To access the tutorials, choose Contents from
Shorthand's Help menu. From the Contents tab, choose Tutorial Demos then Quick
Tutorial.

@ Always keep a backup of your important files

separate from your computer.

It is easy to accidentally delete files by pressing on the wrong button or
selecting the wrong command. For this reason, you should always keep a
copy of your Shorthand dictionary files and other important files on a diskette
or CD. Your Shorthand dictionaries are kept in files ending with .SPF and you
can use the Windows Explorer (p. 11) program to copy the files to a diskette.
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File Converter Utility (SHCNV.EXE)

Shorthand comes with a file converter utility (SHCNV.EXE). To run this utility:

& Shorthand
;_ETE_ Dictionary  Shorcuts  Help
e
Open... Crl+0
Save Cirl+=
Save As.
. Close
1 From Shorthand's Main Menu, =
choose Run File Converter from Ereterences...
the File menu. This launches the Printta File...
Shorthand File Converter <% FunFile Converter
(SHCNV.EXE) utility. Eait
i Shorthand File Converter H=] B3

Click the Start button to convert or merge an existing file to
a Shorthand dictionary file

o/ Stat | [l Close 7 Help |
Shorthand File Converter VEFZ?.'I'I
.”ght (=] 1885_2000 ClEf=aCmFt ] I Dalbe B =l
3 Click the Start 2 Click the Help button for
button to begin the step-by-step instructions.
CONVErsion process.

As of thiswriting the SHCNV.EXE utility can:
Convert text files into Shorthand dictionary (.SPF) files.

Convert Microsoft® Word™ (Versions 6.0 and later) AutoCorrect entries to
Shorthand format.

Convert other word expander formats such as Productivity Plus™ (PRD+),
Smartype™ and Abbreviate™ files into Shorthand format.

Merge two Shorthand dictionaries

In general, the procedure isto first save your word list as atext file (using your
expander's Print to File or Export to File function) then use SHCNV to convert the text
fileto a Shorthand .SPF file. Click on the Help button (step 2 above) for specific
instructions. If your file format is not supported by SHCNV, you can write a Tcl script
to do the job (see p. 118 for an example).
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Terminology

Click and Drag

In Windows, you can move or resize some objects by clicking and dragging. When you
are asked to “click and drag” an object, you first select the object by pointing your
mouse arrow on the object and clicking your left mouse button on it. With the mouse
arrow still on the object, hold down the left mouse button and move your mouse to drag
the object around the screen.

Dictionary
Shorthand stores your list of abbreviations and text in adictionary. On your hard disk
the dictionary is saved in afile ending with .SPF. Y ou can create as many Shorthand
dictionaries as can fit on your hard disk but only one dictionary can be active at any time
(but you can link dictionaries together (p. 40) and let Shorthand access the linked
dictionaries as if they were one big dictionary file). The number and size of Shorthand
dictionaries are limited only by the hard disk space available on your computer. Other
word expanders may use the terms “word list,” “glossary,” or “abbreviation list” to what
Shorthand refers to as a dictionary.

Dictionary Tabs

Dictionary tabs (p. 17) are located at the bottom of the Shorthand Main window and
allow you to quickly open adictionary. You create adictionary tab by creating (p. 18)
or opening (p. 20) a Shorthand dictionary file. Y ou remove atab by closing thefile (p.
45).

Double-clicking

Double clicking on an object means clicking your left mouse twice (in rapid succession)
on an object.

File Shortcut

A File Shortcut (p. 42) is akeyboard command (e.g. Ctrl+F1) you assign to open a
Shorthand dictionary, launch an external file or run a Tcl script.

Hint Window

When enabled, Shorthand displays a small yellow Hint Window (p. 58) whenever you
type arecognized short form. The Hint Window usually appears at the bottom of the
text window in which you are currently typing.
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Hot Key
The Hot Key is a special keystroke you type from within your word processor to call up
Shorthand. By default, the Hot Key is the F10 function key. To change the Hot Key,
see p. 49.

Icon

Aniconisasmall picture that represents afile, program or command. When you start
Shorthand, Shorthand places a small icon of itself in the Windows System Tray on the
lower right hand corner of your screen (p. 13). You can bring up Shorthand by clicking
on itsicon.

Keyboard command / Keyboard shortcut
Keyboard commands are commands issued through a keystroke combination.

For example, Alt+Tab (while holding down the key, press the Tab key) will
switch Windows applications and Alt+F4 will close the current window.

Keyboard shortcuts refer to the keystroke combination that you can use instead of using
the mouse to click on the menus. For example, in Microsoft Word, the keyboard
shortcut to turn bold on/off is Ctrl+B. Since most functions of your word processor can
be assigned a keyboard shortcut, Shorthand can access your word processor's special
functions by simulating the appropriate keystroke combination with Shorthand's @KEY

tag (p. 68).

@ For alist on Windows keyboard commands and keyboard shortcuts see p. 132. To find
the keyboard shortcuts for your word processor, consult your software's documentation.

Keyword

Thisis the abbreviation or short form (p. 27) you create to represent alonger string of
text or keyboard commands.

Keyword Shortcut

A keyword shortcut (p. 28) is a keyboard combination you can assign to a keyword. For
example, if you assign the F9 key as the keyword shortcut for the keyword asap to
represent the phrase "as soon as possible’, pressing F9 will insert "as soon as possible"
into your word processor.

Links

When you link files (p. 40), you are connecting them together with the active dictionary.
Shorthand allows one active dictionary at atime, but the linking feature lets you have
access to more than one dictionary file by connecting them to the active dictionary.
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Menus

Menus are lists of commands. The Main Menu is located at the top of the Shorthand
window with the command categories (File, Dictionary, Shortcuts, Help) listed onit. A
Pop-Up Menu appears when you click your right mouse button inside a window; for
example, clicking your right button in a text window can show you a menu to cut, copy
or paste selections.

Shorthand Folder

The folder on your hard disk where the Shorthand program files were installed. For
Shorthand Version 9 this folder is normally

C:\Program Fi | e\ Short hand for W ndows\ Sh9

If you don't know the name of the folder, you can use Windows Explorer to search for
the file sh9.exe which is the name of the Shorthand program file.

Shorthand License File (SH9.LIC)

When you purchased a Shorthand license, you were given a Registration ID (p. 47)
which, when entered into Shorthand, converts Shorthand into alicensed version. After
you enter the Registration 1D, Shorthand saves your registration into afile called
SHO.LIC in the Shorthand folder. To remove alicense from the computer, Simply delete
the SHI.LIC file; you should remove your license from a computer you no longer plan
to use to prevent others from illegally using your Shorthand license.

START button and Taskbar

At the bottom of your Windows desktop is the Taskbar which displaysicons of active
programs. Shorthand normally does not display itsicon in the Taskbar except when one
of itswindows (e.g. About box) isvisible. If the Taskbar is not visible, moving your
mouse to the bottom of the screen should make it appear. It isat left side of the Taskbar
where you can find the Windows START button. With the START button, you can
start a program or find afile quickly (p. 13).

System Tray

The System Tray isfound at the right side of the Taskbar (on the lower right corner of
your screen). The Shorthand icon can be accessed from here (p. 13).

Suggestion Window Shortcut

When the Suggestion Window is enabled (p. 56), it displays up to nine choices that is
closest to the word being typed. The function keys (F1 to F9) are used as the Suggestion
Shortcut for selecting the choices in the Suggestion Window.
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Tags

Shorthand Tags (p. 65) refer to special commands that you can embed in your Shorthand
long forms to do such things as type out the current date, synthesize a keystroke, display
apick list, import atext file or runa Tcl script.

Tcl

Tcl stands for "Tool Command Language” and is the scripting language used by
Shorthand (see p. 89). Tcl isapopular language with powerful commands to do such
things as arithmetic computations, string manipulation and regular expression parsing.
Teaching you the details of Tcl programming is beyond the scope of this book but you
can find out more about Tcl from the Internet at http://www.scriptics.com.

Text to Type

The Text to Type (also called "long form™ or "macro") refers to the text and keyboard
commands that will be typed out and inserted into your document (see p. 30).

Title Bar

The Title Bar isthe top line of your application's window that contains the name of the
software program. Shorthand's Title Bar also shows the name of the active dictionary
file.

Variable

When creating Shorthand Tags, you have the option of defining a variable (p. 87) that
will hold the results of the Tag. For example, if you assign avariable called { col or s}
to apick list of colors, Shorthand will replace al instances of { col or s} with the items
chosen by the user from the pick list.

Windows Desktop

The large empty area you see when you first start Windows is called the Windows
Desktop. When you install Shorthand, you have the option of creating a Shorthand
shortcut icon on the desktop; double clicking on thisicon will launch Shorthand (p. 13).

Windows Explorer

Windows Explorer is afile management tool included with Windows which allows you
to copy, delete and rename files and folders on your hard disk. Y ou launch Windows
Explorer by pressing

A +
(i.e. while holding down the Windows # key, press the E key).
See your Windows user manual for instructions on how to use Windows Explorer.
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How to use this book

Menu commands

Menu commands will be indicated by bold text with an = symbol. For example,
Dictionary = Show Shortcuts means choose Show Shortcuts from the Dictionary
menul.

Keyboard combinations

The command for keyboard combinations will appear with Ctrl, Shift and/or Alt, the +
sign and the letter command. For example, when you see:

Ctrl+G
This means that you should go to your keyboard and, while holding down the key,

pressthe [G] key. These two keys should be pressed simultaneously to be considered a
keyboard combination. Do not press the + key.

Text to Type box

Y ou will need to be especially careful when entering text in the Text to Type box as
every character, space and line in the Text to Type box will be processed by Shorthand.
In this book, words to be typed in the Text to Type box will look like this:

Text to Type:

Type this in the Text to Type box [
Line 2 [
Line 3 [

Line 4: This is a very long line that cannot fit on one line and
continues to the next |ine.

Line 5

The symbol represents a"hard return” created by pressing the Enter or
Ctrl+Enter key on your keyboard. Note that Line 4 in the example above is one long
line that word wraps to the next screen line. Also note that Line 5 does not end with a
hard return (do not press at theend of Line 5). A common error isto put an
extraneous hard return at the end of the Text to Type which will result in Shorthand
typing out an extraline in your word processor.

Tips and Notes
|mportant information are marked with a & .

Boxes with a @ contain helpful suggestions and tips.
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Chapter 2 Basic Operations

How to start Shorthand
To start Shorthand, click on Windows START button:

then choose Programs = Shorthand 9 = Shorthand 9.x Application.

If you want Shorthand to automatically start up whenever you launch Windows, place
the Shorthand Program icon in the Windows StartUp folder (see your Windows
documentation on how to add a program to the StartUp fol der).

How to bring up Shorthand's Main Window

All the Shorthand functions, properties and word lists are accessible through Shorthand's
Main Window. After starting Shorthand, you can bring up the Main Window as follows:

Method 1: Click on the Shorthand System Tray Icon.

After starting Shorthand, you can access the Shorthand's Main Window by clicking on
the Shorthand icon in the System Tray on the lower right corner of your screen:

W A 444 M

Method 2: Pressthe Shorthand Hot Key

Another quick way to access Shorthand's Main Window is by pressing the Shorthand
Hot Key from your keyboard. By default, Shorthand assigns F10 as the Hot Key (see p.
49 if you wish to change this).

Copyright © 2002-2005 by OfficeSoft LLC (http://pcshorthand.com). It is illegal to copy any portion of this book.
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The Shorthand Main Window

Shorthand's Main Window can be divided into three sections. Main Menu, Keyword
Panel and Dictionary Panel.

Main Menu

[TE0

—p Fil=  Dictionary  Shortcute: Help

Keyword Panel

f Shorthand 9 =]

]'_(B}'word AutoReplace W Type It l
/o

e

Dictionary
Panel

—P Text to Type
c/o
vy Ol 18] B 48 B <—
Kewword Shartcut Dezcription
applezd The apples an the tabletop appeared: Ple
bday date of hirth
choicelaw chaice of law text
—P» cod Al+C child of
cod COMmpany hamme
comp Corporationi@MOSPACE}
cuztomzery customer service qualities
datel {@KEY Shift+Ctl+B HEKEY Shift+Crrl+ He
date? current long date
dj Diocezan Jubilee
equit Equitable Bank
aveall [, [ — i aweal _'.!

]\U ntitled ) girmyl ,innancialj <

The Main Menu
The Main Menu contains these four top-level menus:

File menu

Shorthand How-to Guide

Drag this bar
to adjust panel
heights

Speed
buttons

Dictionary
List Box

Dictionary
File Tabs

This menu contains commands to create, open, save and print dictionary files. Shorthand
dictionary files are saved on your hard disk with an .SPF extension. This menu aso
contains commands to access Shorthand preferences and run the file converter.

Dictionary menu

This menu contains commands to create, modify or remove entriesin the active
dictionary file. In this menu, you can also search for specific entriesin dictionary files
aswell as copy entries.
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Shortcuts menu

This menu displays your Shorthand File Shortcuts. A File Shortcut is a keystroke
combination to open a Shorthand dictionary, launch another application or run a
Shorthand Tcl script (see p. 42).

Help menu

This menu provides on-line documentation on Shorthand and usage statistics.

The Keyword Panel
L ocated right below the Main Menu, the Keyword Panel contains boxes for the Keyword

15

and Text to Type.
5 Shorthand M=l E3 IQ)? éﬁg}ul:f:place
1 Type the Fie Dictionary Shorcuts Hedp | normally be
abbreviation to K epmord Autchloplace kI/epc/ checked.
search for in the _—
{Hide ]
Keyword box. Tl T s
: . - 3 Click the Type It
Click and drag the \ #| button to insert the
Separator Bar to = 2 Ifthe keyword exists in the — Text to Type into
resize the Text to dictionary, its long form appears your word
Type box. in the Text to Type box. processor.
Keyword box

To look for akeyword, type it into the Keyword box and the closest matching entry
appearsin the Dictionary list box. You can press the Up and Down arrow keysin the
Keyword box to scroll to the next keyword in the list.

AutoReplace checkbox

If this box is checked, AutoReplace will be enabled and Shorthand will automatically
detect and replace keywords as you type in your word processor. Since thisis what you
normally want Shorthand to do, always make sure this box is checked.

Text to Type box

When you type a recognized keyword in the Keyword box or select an entry from the
Dictionary list box, the text associated with the keyword appears in the Text to Type box.
Y ou can edit or enter additional text in the Text to Type box before clicking on the Type
It button. Changes you make in the Text to Type box are temporary and will not be
saved. To change the size of the Text to Type box, click and drag the Separator Bar
below the Text to Type box.



Shorthand How-to Guide

TYPE IT button

Clicking this button will command Shorthand to insert the contents of the Text to Type
box into your word processor. The TYPE IT button is enabled only if Shorthand was
activated from your word processor with the Hot Key (p. 49); the reason for thisis by
design: Shorthand needs to know where to insert the text and pressing the Hot Key (F10
by default) tells Shorthand exactly where to place the text. If you had activated
Shorthand by clicking on itsicon in the System Tray, the TYPE IT button is disabled
because Shorthand doesn't know which window to insert the text.

@ Pressing the key in Shorthand's Main Window is equivalent to clicking on the
Type It button.

HIDE button

When you click on this button, the Shorthand Main Window will minimize to the System
Tray (p. 10). If the AutoReplace box next to the Keyword box is checked, Shorthand
will replace abbreviations as you type.

Pressing the [ key in Shorthand's Main Window is equivalent to clicking on the HIDE
button.

The Dictionary Panel

Located right below the Keyword Panel, the Dictionary Panel is where you manage
your word lists.

Speed buttons
Open Save Addanew | Modify
dictionary dictionary entry selected entry

Delete Enable/Disable Preferences
selected entry Links

With asingle click, the speed buttons conveniently let you access common Shorthand
operations.

@ To determine the function of a button, move your mouse pointer over a speed button.
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&

Dictionary list box

Keywords are arranged Columns can be resized by
alphabetically and are not dragging the vertical lines
case sensitive. separating the column titles.

.

Shortcut

The apples on the tabletop appeared: Fle
bday date of birth

The Dictionary list box displays the keywords, shortcuts and their associated text in the
active and linked dictionaries. The Shortcut column can be enabled/disabled by
choosing Dictionary = Show Shortcuts.

Dictionary File Tabs

o -
I e i T e B el i

]\U ntitled ) gimyl r‘.fhancialf

%

Click on a tab to quickly open a
dictionary.

The Dictionary file tabs below the Dictionary list box display previously opened
dictionary files; you can think of the tabs as a "file history" list. The tabs give you quick
way to reopen a dictionary and make it the active dictionary.

To create a new tab:

Open the dictionary by choosing File=>Open or Files>New.
Toremoveatab:

Click on the tab to make it active then choose File=>Close.
Toreorder tabs:

Click and hold down the left mouse button on the tab and drag the tab to the new
position.

While you can have many dictionary files displayed on the tabs, Shorthand only allows
one active dictionary at atime. To access the contents of two or more dictionaries
simultaneously, you will have to link them to the active dictionary (see p. 40).
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How to create a dictionary

Shorthand stores your word listsin dictionaries. Each dictionary is saved to a standard
Windows file with the extension .spf; you can create as many dictionaries as can fit on

your hard disk and moving your dictionaries to other computers is as simple as copying a
file.

To create adictionary in Shorthand:

1 From Shorthand's Main Menu, choose . onorthand
File>New. The New Dictionary window |~ Ele Diction=sy Shericuts Help
appears.

Qpen... CArl+
SEVE Cirl+ 3
SEve A

Close

Praterances...
Frint to Eila...
Eun Fila Comserar

Exit

2 By default, Shorthand saves your dictionaries to the
Shorthand folder. To save to a different folder, click in the
Save In box and select a new folder.

Mew Dictionary

Save in: |_:__‘i Sh j gl E
|1 chapterzips El Demol.zpf El medical. SPF El Whspf ) ]
|1 File Converter iiﬁl Demod zpf Ii!;‘l Pazcal spf 4 Click Save to create the file.
..:I Mew Folder [2) H Dema-tel spf i_ﬂ prd. SPF Shorthand's Main Window

:ﬂ adeline. SPF 5 example SPF g‘ Prt SPF reappears and you should see
=] autocon spf ] example2 SPF (=] Typos.spf a new dictionary tab with the
=] Awards SPF (=] gimy1.SFF =] Untitled. spf dictionary name.

4| | i3
File narme: I k Save ﬂ
Save az type: IDictionariE\[".spf] j Cancel

\

3 Type the new dictionary name in the File name box.

Warning: If you specify an existing filename, Shorthand displays a
warning message and asks if you really want to replace the
existing file. If you answer Yes all entries in the file will be erased
and will be lost (but may be recovered if Shorthand had created a
backup; see p. 19).
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How to save a dictionary

When you make changes (i.e. add new entries, modify an entry, etc.), your modifications
are not made permanent until the dictionary is saved to the hard disk. Y ou can command
Shorthand to save your dictionary as follows:

To save changes and update your dictionary [ Eie Dictionary Shottcuts  Help
file, choose File=>Save. New
Oper... Clrl+0
Y Save ) Ctrl+5
Save Az,
Lloze

To make a duplicate copy of the dictionary to BT
another folder or disk, choose

File=>Copy To. [, PinttoFile..

Hun File Converter
Tcl Script... F3

E xit

Automatic saving

By default, Shorthand automatically saves your dictionary files when you click on the
Hide button, open another dictionary or shut down Shorthand. Y ou can enable or
disable the automatic saving through the Preference window (p. 62).

Backup files

When adictionary is saved, Shorthand automatically makes a backup copy of the
original file. The backup copy is saved to afile with extension ".~SP". Y ou can restore

the original data by using Windows Explorer (p. 11) to rename the backup fileto its
origina name.

Backing up to a diskette

Y ou can make a copy of the dictionary to afloppy diskette or another folder by choosing
File Copy To.

@ Always keep a backup of your important files
separate from your computer.
It is easy to accidentally delete files by pressing on the wrong
button. For this reason, you should always keep a copy of
your Shorthand dictionary files and other important files on a
diskette or CD. You can use the Windows Explorer (p. 11)
program to copy files to a diskette. Your Shorthand
dictionaries are kept in files ending with .SPF.
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How to open an existing dictionary

Shorthand How-to Guide

Shorthand can only recognize abbreviations that are in the active dictionary. To make a

dictionary active, you have to open it.

To open adictionary:

&5 Shorthand
1 From Shorthand's Main =

| File Dictionary Shortcuts  Help

Menu choose File=>Open. New

box appears.

Save A5,
Close

The Open Dictionary dialog \, Cirl+ 0

Sawve Cirl+5

Ereferences..
Printto Eile...
Eun File Conwverter

Exit

folder, click in the Look In box and select a new folder.

2 By default, Shorthand looks for dictionaries in the Shorthand folder. To look in a different

Open Dictionary

Loskin | Sh = =S

4
Z

File name: Imedical.SF’F Open

Files af lwpe: IDictinnar;yﬁspf] ;! Carcel I

1 chapterzips 28] Demal.spf |8] girry. SPF 28] Pit.SPF
|1 Fils Corwerter @ Demad.spf EI aimy1.5PF |§| Typoz. zpf
|1 Mew Falder [2] ;ﬁl Dermo-tcl. zpf ;ﬁl Untitled. zp
EI adeline. SPF @ example. 5FF [#Peviname. SPF EI Wb, spf

EI autocorr, zpk EI example?, SPF / Fazcal spf

[#] Awards. SPF |8 financial SPF |#] prd.5PF

4 Click Open to load the
selected file. Shorthand's
Main Window reappears and
you should see a new
dictionary tab with the
dictionary's name.

3 Select the dictionary to open. Shorthand dictionary names
end with the extension ".SPF".

Dictionary tabs (p. 17) allow you to quickly reopen Shorthand dictionaries. When a
dictionary is created or opened, atab will appear in the Shorthand Main Window. To

reopen a dictionary, simply click on its tab.
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How to print a dictionary

To print the Shorthand dictionary word lists, you have to first convert the dictionary to a
text file and use your word processor to print the text file:

e

1 Open the dictionary you want to

and be the selected dictionary tab.

rename (p. 20). The dictionary's name
should appear in Shorthand's title bar

Kewword

SRR R
i Shorthand 8.00 (RC2] - girny1 . SPF
TR

File  Dictionary  Shortouts

AutoReplace ¥

It I

2 From Shorthand's

T L maciaan ftoaveal o |
Untitled & girmyl ancial j
b o

& Shorthand

| File Dictionary Shortcuts  Help

R [=
Main Menu, choose Open.. Cirl+0)
File=> Print to File. S Chl+8
The Save As dialog e
box appears. C|DSE_

Freferences..

Printto Eile...

BEun File Conwverter

Exit

3 By default, Shorthand saves your dictionaries to
the Shorthand folder. To save to a different folder,
click in the Save In box and select a new folder.

T

@See p. 115fora

Tcl script that can
export your word list
to a comma-delimited
file.

Save jn; |t§i Sh

=1 &l ol [

3 chapterzips % Readme. txt

|1 File Converter E’l ShBwhatsnew et
1 Mew Folder [2) @ Shcri. bt

S| AUTOCORR. 5] Tcl Read Me
E] rewvanne, TaT @ TelReadme. tat
%’J Read Me First E:l Wihat's New

File narme: ! k

Save i

Save az upe: ITer:t File [".h]\

5 Click Save to print the
dictionary to the text file. You
can then open the text file in
your favorite word processor
program (e.g. Microsoft Word)
and print out the word list from
there.

_:! Cancel |

4 Type the name of the destination text file in the File name box. Warning: If you specify an existing
filename, Shorthand displays a warning message and asks if you really want to replace the existing file.
If you answer Yes all entries in the selected file will be erased and will be lost.

21
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How to rename a dictionary

Y ou can change the name of an existing dictionary in Shorthand by saving it under a
different name. To save a Shorthand dictionary under a different name:

1 Open the dictionary you want to
rename (p. 20). The dictionary's name
should appear in Shorthand's title bar
and be the selected dictionary tab.

Kemanrd

Ve "
55 Shorthand 8.00 [RC2) - ginyl.5PF
B

File Dictionary  Shortci e

ZutoFieplace W

Shorthand How-to Guide

(=1 I

T L maciaan ftoaveal o |
Untitled & girmyl ancial j
b o

2 From Shorthand's Main Menu,
choose File=>Save As. The Save
Dictionary dialog box appears.

iler Dictionary Shorcuts
New

Open... Ctrl+0
Save Cirl+5

Close

& Shorthand

Help

Ereferences...
Frintta Eile...
Bun File Conwverter

Exit
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3 By default, Shorthand saves your dictionaries to the Shorthand folder. To save to a
different folder, click in the Save In box and select a new folder.

Save Dictionary

Savein: |\_;_‘I Sh V :] g! E

| chapterzips El Demol. spf El gimy1.5PF El ntitled. zp
| File Conwverter  [3] Dema2 spf [#] medical SPF [#] b5t 5 Click Save to create the
|1 Mew Folder [2) :ﬂ Dremio-tel.spf :ﬂ Pazcal sp new file. Shorthand's Main
@ adeline. SFF @ example, SFF @ prd SFF Window reappears and you
[®] autocor. spf [®] example2 SPF :s_lj; Frt.SPF should see a new dictionary
iﬂ Auwards. SPF Iﬂ financial SPF {#8] Typos. spf t . -
ab with the dictionary name.

4 | i

| w
Save as hope: IDictioneﬁes\[".spf} :_l Cancel |

4 Type the new dictionary name in the File name box..

Warning: If you specify an existing filename, Shorthand displays a warning message and asks if you
really want to replace the existing file. If you answer Yes all entries in the file will be erased and will be
lost (but may be recoverable if Shorthand had created a backup; see p.19).

@ Notes

When you use the Save As command, Shorthand creates a duplicate file; the file with

the old name will remain on your hard disk. Y ou can use Windows Explorer (p. 11)
to remove unneeded files.

Since dictionaries are stored as norma Windows files, you can aso use Windows
Explorer to rename the file; if you do this, you will need to choose Files>Open from
Shorthand's Main Menu to reload the file (p. 20).
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How to add new entries to a dictionary

Use any one of the five methods below to create a new entry in the active dictionary.

MethOd 1 File: QAMTRENN Shortouts  Help MethOd 2

From Shorthand's Press the [INS] key on your

Main Menu, choose Modify F2 keyboard anywhere in

Dictionary=>Add. Shorthand's Main Window.
Dictionan:

Method 3

Click on the third speed
button located above the
dictionary list box.

The apples an the tabletop
date of hirth

choicelaw chaice of law text

Method 4

In your word processor,
press Alt+ins.

NOTE: For this to work,
AutoReplace and the
Alt+Ins options must be
both enabled (see p. 55).

Method 5

In your word processor, highlight the block of text you want to add then press Ctrl+Ins twice (i.e., while
holding down the [[cTr ] key, press and release [INS] then press and release [INS] a second time).

NOTE: For this to work, AutoReplace must be enabled (p. 51). This feature also requires that your word
processor recognizes the Ctrl+lns command to copy text to the clipboard.
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When you create a new entry, Shorthand displays the Dictionary Text [ Add] dialog box

for you to enter the Keyword (short form) and Text To Type (long form).

in the Keyword box (see p. 27)

1 Enter the short form (abbreviation) Click the Shortcut buttor_1 if you wish to create a
keyboard shortcut for this entry (see p. 28).

Ey Dictionary Texst [Add]

M Shortcut F

asap |

Test To Type  [Options m

(:" as soon as possible =
3 Check the line count to make

0

H[=] E3

X Cancel

? Help

. sure you don't have extra lines in Hecord
2 Enter the long form in the Text to Box (see p. 31). SpelCheck
the Text to Type box
(see p. 30).
The Record button is helpful for
adding complex keystroke
sequences to the Text to Type
{Tags) | Unda | [E0it | Eopy | Easte | Select Al I box (See P. 32)
Descriptian
| w_

Enter an optional comment or title in the Description box. What
you enter in this box will appear in the Dictionary list in
Shorthand's Main Window. If you leave this box empty,
Shorthand uses displays the first 60 characters of the Text to
Type box in the Dictionary list.

@ See Appendix C: Tips for Touch Typists (p. 131) for an example of how to efficiently

add entries while you type.
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How to delete dictionary entries

Y ou can remove (delete) an entry from your dictionary as follows:

iy Shorthand

M [=] E3

File Dictionary  Shorteutz Help

Kewword

AutoReplace W

]

Test to Type

Tuype it |

1 Bring up the Shorthand Main
Window (p. 13) and select the
entry you wish to delete from the
Dictionary list box.

Dictiorary: E‘PIHI Di!l _WJ

T

at?

bday
chioicelaw
equit

anemall

Description

as soon as possible
The apples on the tabletop appeared: Fle
date of birth

choice of law text

E quitable B ank.
| 2 e T ft asmal

- |

\Untitled L airy] ,Q financialj

2 Use any one of the three methods below to create a new copy of the selected entry.

Method 1

From Shorthand's Main Menu,
choose
Dictionary=>Remove (Cut).

Paste
Duplcate

Method 3

Click on the "trash can" speed
button above the Dictionary list
box.

> CEemove Gl >

%1 Shorthand

Fle Shoteuts  Help
aad... Iz
Modiy F2

Method 2

keyboard.
Alelns

Press the [[DEL] key on your

Dictionany:

&

The deleted entry is copied to the clipboard so, if you make a mistake, you can undelete

Fepword

at2

an entry by choosing Dictionary= Paste.

as soon as possible
The apples on the tabletop appeared: Fle
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How to define short forms or abbreviations

When you add a new entry (p. 24), Shorthand displays the Dictionary Text [ Add]
window. Enter the short form (abbreviation) in the K eyword box.

Enter the short form (abbreviation) in
the Keyword box.

5 Dictionary Text [Add] | |O] x]
Fepword Shortout | « OF
asap |
x Cancel |
Tewt To Type  [Options 1 line
as soon as possible | 7 Help |
Record |
Spell Check |
{Tags}-l Unda | [Enit | [Eripy | Hagte | Select Al I
Description

@ Notes

Keywords are limited to 32 characters and can contain any printable character and
spaces.

Keywords are not case sensitive.

If you want the keyword to be replaced as you type, the keyword should not contain
gpaces. Or, to put it in another way, keywords with spaces will never be
automatically expanded as you type (but can still be manually expanded by selecting
the keyword from the Suggestion Window (p. 56) or from the Dictionary list and
clicking on the Type It button).

Keywords must be unique; a dictionary cannot have two entries with the same
keyword.
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How to define a keyword shortcut

Y ou can further decrease keystrokes by assigning a single keystroke to expand the
keyword. Whenever you press a recognized keyword shortcut, Shorthand will
immediately insert the keyword's Text to Type into the your word processor.

To define a keyword shortcut:

1 Bring up the Dictionary Text window (see p. 24 if you are creating
a new entry or p. 34 if modifying an existing entry).

2 Click the Shortcut button.
The Next Key Typed window
appears.

Ey Dictionary Text [Add]

Keyword
| asap

o OK
X Cancel |
Text Ta Type  [Optons 1 line

as soon as possible = ? Help

Mext Key Typed

The next key typed will be the
key assigned to the shortcut

X Cancel |
3 Inthe Next Key Typed window,

press the keystroke (e.g. Alt+T) you
want assigned as the shortcut. The

Select Shortcut Key window appears

and shows the key you just typed. Lo Koy l/ 4 Click the OK
&I button to accept
R the keystroke.
] L toxed) I The Dictionary
o WM@EE [ Shit 2 Hep Text window
Mext Key Toped | Clear I feappears.

If you want to change the
keystroke, click the Next Key
Typed button to start over.
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The shortcut you chose will appear in 5 Click OK to save the
the Dictionary Text window under the entry
Shortcut button. '

By Dictionary Text [Add] H=l E3

Keypword \ Shartcut I ‘
[oani Q@ X Cancel |

Test To Type [Ophions 1 line
as soon as possible = “? Help
iy Shorthand Hi=]

File Dictionary  Shortcute Help

Kewword AutoReplace W T ral! I

The Shortcut appears in the Dictionary Teutto Type
list box. Whenever you press the
Shortcut key (Alt+T in this example),
Shorthand will insert the long form into

your word processor. DM gl ol @
'.-'IHH!H-.

at2 The apples on the tabletop appeared: Ple
bday date of birth
chioicelaw choice of law text

If you want to use function keys (F1, F2, etc.) as keyword shortcut keysit is
recommended that you combine them with Ctrl, Shift, and/or Alt to avoid conflicts with
the Suggestion Window which uses the F1 to F9 keys.
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How to define long forms

The text to be inserted to your word processor (i.e. the long form) should be entered in
the Text to Type box of the Dictionary Text window. Y ou can bring up the Dictionary
Text window by either creating a new entry (p. 24) or modifying an existing one (p. 34).

Enter the long form in the The line counter (see p.31)
Text to Type box. shows the number of lines in the
Text to Type box.

Bt Dictionary Text [Add] Hi=] E3

asap
I I x Cancel |
Text To Tune  [Oobons] 1 line A

as soon as possible > ...‘_I ? Help |

Record |
Spell Check |

{Tags) Urnda [E6it [Erpy Easte Select Al
R R R R

Description

@ Notes

With the exception of Shorthand Tags (p. 65), Shorthand will type out whatever you
enter in the Text to Type box exactly asyou typeit in.

Shorthand can only simulate keystrokes. To do special things like change font styles
(p. 70) or insert specia characters (p. 71) you will have to use Shorthand's { @KEY'}
tag to simulate your word processor's keyboard command. Mgjor word processors
allow you to assign keyboard shortcuts to virtually any of their functions so you
should be able to use Shorthand to control your word processor by simulating the
appropriate keyboard command sequence.

Be careful of extralines at the end of your long form. Extralines at the end of your
text are invisible and will be typed out by Shorthand with the rest of your text. You
can determine the number of lines in the Text to Type box by clicking on [Options]
(above the Text to Type box) and deselecting the Word Wrap option. The number of
linesin the Text to Type box will be displayed above the top right corner of the Text
to Type box (p. 31).
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How to determine the number of lines in the Text
to Type box

Shorthand types out al text in the Text to Type box including blank lines. Theline
counter in the Dictionary Text window helps you determine if there are blank lines at the
end of your long form in the Text to Type box.

To turn on the line counter:

1 Bring up the Dictionary Text window (see p. 24 if you are creating
a new entry or p. 34 if modifying an existing entry).

2 Click on [Options] then deselect the Word Wrap option by
clicking on it once or twice until the checkmark disappears.

By Dictionary Text [Add]

F.ewword J Sharteut I
|
I v |

Cancel
Test To Tvpe { [Options x |
Wwiord Wrap B
: Hel
TTEETF e = Tab Character = ? Help |

v [EMTER] Key=Mew Line

Record

The number of lines in the Text to Type box
appear just above the Text to Type box.

Ey Dictionary Text [Add] Hi=

|

Fewword Shartcut | | J oK,
asap

I I X Cancel |
Test Ta Type  [Options 1 line

as soon as possible = ? Help |
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How to use the Shorthand Keystroke Recorder

To simulate special keystrokes (e.g. F1, Shift+Home, etc.) you will need to enter the
appropriate { @KEY} tagsin the Text to Type box. To make your job easier, Shorthand
has the ability to directly record your keystrokes into the Text to Type box.

To use the recorder:

1 Bring up the Dictionary Text window (see p. 24 if you are creating
a new entry or p. 34 if modifying an existing entry).

Ey Dictionary Text [Add]

Kevword Shartcut |
I I X Cancel |

Text Ta Type  [Ophions 1 line

Spell Check i

{Tags}l Qndol [E0it | Eoipy | ":,l Select Al

Drescription

2 Click the Record button. The Recording Keystrokes window
appears (usually at the top right corner of your screen). The title bar
of the Recording Keystrokes window blinks to indicate that anything
you type is now being recorded.

V

By Recording Keystrokes  [H[E] E3
| 1 Feys
X Cancel
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3 Use your mouse to switch to your word processor's window. Shorthand will not record
mouse commands so anything you do with your mouse will not be recorded.

I

@ Microsoft Word

I 4 Start typing in your word processor. Remember
that Shorthand will only record keystrokes so ,if you
need to access your word processor's functions, be
: sure to use your word processor's keyboard

= commands. For example, to do a Search in
Microsoft Word, you should first press Alt+E (to
access Word's Edit menu) then press F (to choose
the Find function).

5 To stop recording, grab your mouse and click the Stop button in
the Recording Keystrokes window. The Dictionary Text window '

:‘f'g Recording Keystrokes
reappears with the recorded keystrokes appended to the Text to

HE E3
| 1 Feys

Type box. You can edit the contents of the Text to Type box.

X Cancel
v

iy Dictionary Text [Add] M=l E3

Fewword Shortcut |
searchl

I I X Cancel |

Test To Type  [Options i

{@KEYDOWN Alt}e{@KEYUP Al =] 7 e |

Becord |
Spell Check I

i
2

33
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How to modify dictionary entries

To edit or change an existing entry:

[TE0

Fil=  Dict

f Shorthand 9 =]

jionary  Shortouts Help

Keywiard AutoReplace W Tl l

] /o :

Tewt to Type ;
c/o

1 Bring up the Shorthand Main

Window (p. 13) and select the T E"IHI '-5|| _WJ

entry you wish to modify from the
Dictionary list box. \ Keyword

Shartcut Description

applezd The apples on the tabletop appeared: Ple
bday date of birth

choicelaw choice of law text

cod Al+C child of

el (- I — Bt el |
‘\Unlitled ) gyl r‘.financialjf

2 Use any one of the three methods below to bring up the

Dictionary Text [Modify] dialog box.

"r;.].: Shorthand

MethOd 1 Eile [l |:.I|:::._
From Shorthand's ‘
Main Menu, choose P Fiodiy
Dictionary=>Modify.

iy Shorthand
File Dictionary  Shortcuts Help

Shorteuts Help Method 2

Ine Press the F2 key on your
F2 keyboard anywhere in
Shorthand's Main Window.

Keyward AutoReplace W
] o
Teut to Type MethOd 3
c/o Click on the Modify

speed button.

The appl

lex an the tabletop ar

bday date of hirth
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When you edit an entry, Shorthand displays the Dictionary Text [ Modify] window for
you to change the Keyword (short form) and/or Text To Type (long form):

3 Change the short form (abbreviation) in Click the Shortcut button if you wish to create a
the Keyword box (see p. 27). keyboard shortcut for this entry (see p. 28).
yw p
By Dictionary Text (Modify]
ic |
Test To Type [Ophions 1 line ml
C:# o / = ? Help
5 Check the line count to make Recard |
sure you don't have extra lines in
4 Change the long form the Text to Box (see p. 31). Sielie
in the Text to Type box
(see p. 30). I

adding complex keystroke
sequences to the Text to Type
box (see p. 32).

| The Record button is helpful for

{Tags}'l Unda | [Eut | Eripy | Easte | Select Al I

Description

. |

Enter an optional comment or title in
the Description box.

@ How to determine if your dictionary has been modified.
If you modify an existing entry, create a new entry, or delete an entry
Shorthand displays [modified] after the dictionary name on the title
bar of the Shorthand Main Window. The [modified] disappears
when the dictionary is saved.




36 Shorthand How-to Guide

How to duplicate an entry

Y ou can create a new entry based on an existing entry as follows:

& Shorthand |_ (O] %]

File  Dictionary  Shortcuts Help

Kemuaord EutoFieplace W Tupe t |

Teut to Type
1 Bring up the Shorthand Main oiionay. || 015 W &8 B
Window (p. .13) and s(?lect the \ Keyword  |Shorteut | Description -
entry you wish to duplicate from as soon as possible
the DiCtionary list box. at2 The apples on the tabletop appeared: Ple
bday date of birth
choicelaw choice of law text
equit Equitable Bank
o 20 1 [ . _'.!

]\U ntitled ) girmyl ,innancialj

2 Use any one of the two methods below to create a new copy of the selected entry.

53 Shorthand

File WEEEGTETE Sholculs  Help

fdd... I

Modiy F2

By (G Method 2

LCopy
Method 1 L Pasle Press the Alt+Ins key on
From Shorthand's Main ‘4’@ Alb+ns your keyboard in Shorthand's
Menu, choose Main Window
Dictionary=>Duplicate. '
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When you duplicate an entry, Shorthand displays the Dictionary Text [ Add] window for
you to enter a new Keyword (short form) and Text To Type (long form). Remember that
you are editing a copy of the original entry so you should change the keyword to

something else as Shorthand does not allow two entries to have the same keyword.

3 Enter a new short form in the
Keyword box (see p. 27).

Click the Shortcut button if you wish to create a
keyboard shortcut for this entry (see p. 28).

Ef Dictionary Text [Add]

I[=]

]

M Shortcut F

asap |

x Cancel |
Test Ta Type  [Optiohs m

(:" as soon as possible _._! ? Help
5 Check the line count to make

The Record button is helpful for
adding complex keystroke
sequences to the Text to Type
box (see p. 32).

. sure you don't have extra lines in
4 Enter the long form in the Text to Box (see p. 31).
the Text to Type box
(see p. 30).
{Tags} | Unda | [E5it | [y | Easte | Select Al I
Description
| V\

Enter an optional comment or title in
the Description box.

@ Use the Duplicate function to quickly create
different forms of an abbreviation.

For example, if you have an entry for immunize , you can

quickly create a new abbreviations for immunization ,

entry.

immunizing , etc. by duplicating and modifying the immunize
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How to copy an entry to another dictionary

To copy dictionary entries to another dictionary:

By Shorthand T =]
ke Add. Ing . .
et it = 2 From Shorthand's Main

Menu, choose
Dictionary=>Copy. The
selected entries are copied to
sl the clipboard.

== Find.. Chrl+F =

Diict Search &gain  F3 e
E v Show Shortcuts __A_I
1ecl Enable Links E itemz are accepted in good or
s Pratect. .. S0

1 In the Dictionary list box ! I =

ry : 1 —rarrrerr Metro Manila
select the entry you wish to shatz? customer contact information
copy. sympsz] patient's symptams upon entry

1@KEY Tabl

To select a block of entries,

hold down the Shift key

and click the left mouse :

button over the last entry of launch microzoft word program
the block. 4 Untitied ) airmyl #newiame.l'

/

3 Open (p. 20) or create (p. 18) the dictionary you
want to copy the entries to.

5 Shorthand
Fil= EA=IGETEE Shorcu: Help

Add . Ing
Modify F2

4 From Shorthand's Main Menu, choose
Dictionary=>Paste The selected entries are Rremorve: (Cut)
pasted from the clipboard to the dictionary. Eopy

_ Pate D

Duplicate Akslng

If apasted entry already exists, Shorthand automatically assigns a unique keyword (the
duplicate keyword will have a number after it).
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onary entries

If you are looking for a dictionary entry that contains a particular word, you can perform
a simple search through the active dictionary as follows:

2 In the Find What box, type
in the word you are looking for.

Eie Shortcuts  Help
Add. Inez:
1 From Shorthand's Madiy F2
Main Menu choose Remeve [Cull Find
Dictionary=>Find. Cops Fodwhat: [soon
The Find dialog box Paste
appears. Duphcate At
CeleF [ Match caze
Seaichdpsn  F3
3 Click the Find Next
button to start the search.
&5 Shorthand
fgShothand  mEE| Ehmf Lhe
File  Dictionary  Shortcuts Help ﬁ:l':w F’;
Eewword A 4 If fOUI'ld, Shorthand =
| asap displays the entry Femove (Cut)
Testto Type containing the word. E’P!I"
— Fasle
as [ as possible = Duplicate Altslrs
_'"J Eind... Cil+F

Dictionany: E’!F]l Dl!i _ﬂ‘j

Dezcription

as soon as possible

at?
bday

The apples on the tabletop appeared: Ple
date of hirth

fields; to search for a Keyword, smply

Fﬂ

5 Press F3 or choose
Dictionary=>Search
Again to continue the
search.

The Dictionary=Find function searches through the Text to Type and Description

type in the Keyword box (p. 15)

See adso p. 122 for aTcl script that performs searches with wild card pattern

matching.
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How to link dictionaries

Shorthand allows only one active dictionary at atime. However, you can link inactive
dictionaries to the active dictionary which allows for access to more than one dictionary
at atime.

Adding dictionaries to the Links list
Linking adictionary is simply a matter of specifying the dictionary's filename in
Shorthand's Links list. To add a dictionary to Shorthand's Links list:

&5 Shorthand

| File Dictionary Shortcuts  Help

R [=
1 From Shorthand's Main Qpen.. Citl+0
Menu choose Save Chrl+3
File=>Preferences. The Save As..
Preferences window \* Close
ppears
Printto File...
Bun File Converer
Exit

2 Select the 5. Links tab.

Shorthand Freferences - C:A\SHORTHNDAS horthnd. ini

1. Operation | 2. Display | 3. File Shortcuts | 4. .&utnF!epIa
6 Click OK to

Uze thiz list to link. other dictionaries into the active dictionary.

when done.

r’\network\shared.spf X Carcel |
c:A\Program Files\Shorthand\Sh8\med spf

? Help |
sd D R
4 Remave I m 5 Make sure the Enable

st items b . Links box is selected.
3 Click the Add button  [emhashi{ 4 To reorder a st item, b ather list items.
to add a dictionary to the use your left mouse button I
list. I~ | toclickand drag an item to
a new position.
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How linking works

&

When you open adictionary (e.g. by choosing Files>Open) Shorthand first reads in the
entries of the dictionary you specify and, if the Enable Links option is enabled,
Shorthand proceeds to read in the entries of the dictionariesin the Linkslist.

The sequence of the dictionaries in the Links list box isimportant as Shorthand will 1oad
the linked dictionaries in the order they appear in the list. Shorthand doesn't support
multiple entries with the same keyword so, if the same keyword appears in two or more
linked dictionaries, the keyword in the dictionary that is loaded first gets priority.

Y ou can only edit entries in the active dictionary (i.e. the dictionary you opened last and
whose name appears when you choose Dictionary=>1nfo). Linked entries cannot be
modified. To modify alinked entry, you will first have to make its dictionary the active
dictionary by opening it (see p. 20).

How to enable/disable links

To unlink (unmerge) dictionaries, deselect the Enable Links option. To link the
dictionaries again, select the Enable Links option.

B Shorthand

Eile WNSIGEG Shortcut:  Help

Add...
Modify

Ins
F2

Bemove [Cut)
Copy

Paste
Duplicate

Find...
Search Again

Alt+lnz

Method 1

Select or deselect
Enable Links from the
Dictionary menu.

Chil+F
3

v 5 cuts
Enatle Links

Frotect...
Infa

M [=] E3

Tuype it |

iy Shorthand
File Dictionary  Shorteutz Help

Keyward AutoReplace W

Method 2 i
You can enable or disable links by |
clicking the Links speed button.

] H

Drictionany: E"I F.li _mj

Description

as soon as possible
The apples on the tabletop appeared: Fle
date of hbirth

at?
bday
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How to create a Fi

Shorthand How-to Guide

le Shortcut

Y ou can create afile shortcut to open a Shorthand dictionary, launch an external
application (e.g. Microsoft Word) or run a Shorthand Tcl script with a single keystroke.

To create afile shortcut:

1 From Shorthand's Main
Menu choose
Shortcuts=>Edit. The

3. File Shortcuts tab of
the Shorthand Preferences

¥ Shorthand
File Dictionay BELLLTENEY Help

The Specify a File Shortcut
dialog box appears.

window appears.
Shorthand Freferences
2 Click the Add button. 1. Dperation i 2 Dizplay 3. File Shortcuts |i. AutoReplace i 5. Links I

Use this list to define a shortcut to open a dictionary or program

Shortcut Dictionary ar Program
x Cancel
? Help l

Add Edit Bemove

Usze the Windows Program Manager or Explorer to drag and diop files to the list.
Reoider the list items by dragging a hist item with the left mouse button.

4 Click the Shortcut

button. The Next Key
Typed window appears. \(\‘ Shortcut | ) ? Help

3 Click the Browse button and select
the file to be associated with the
shortcut key.

Specify a File Shortcut

oF 0K
Dictionary or Program Hame i ]
I CASHBA\TYPOS.SPF X Cancel

ifi

Deszcription
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Hext Key Typed

The next key typed will be the
key assigned to the shortcut

X Cancel I
v

Select Shortcut Key

5 Inthe Next Key Typed window, press the
keystroke (e.g. Alt+T) you want assigned as the
shortcut. The Select Shortcut Key window appears
and shows the key you just typed.

Mext Key Toped Ear

" OK

I X Cancel
T ~—l If you want to change the

[ICHR T T i 7 Help I || keystroke, click the Next Key
Typed button to start over.

6 Click the OK button to accept
the keystroke. The Specify a File
L Shortcut window reappears.

Specify a File Shortcut

7 Inthe Description box, enter a
short string describing the Dictionary or Program Mame B l
command. | C:\Sh8\Typos.spf

MOTE: Filenames containing spaces must be encloged
in double quotes, e.qg. "C:hky File"

|AltsT

Description

8 Click the OK button to
save the entry and return
to the Preferences window.

Shorthand Freferences

1. Operation i 2 Display 3 File Shortcuts Ii. AutoReplace I 5. Links I

Uze this list to define a zhortcut to open a dictionary or program

Shartcut Dictionary ar Program

10 Click the OK

9 Verify that the new button to close the

Add Edit | Bemove |

entry appears in the
list.

Preferences window
and return to

Uze the Windows Program Manager or Explorel

Reorder the list items by dragging a list item with the left mouse button.

7 i Shorthand.
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Using the File Shortcut
Y ou can now open or launch the specified file by pressing the shortcut key (e.g. Alt+T)
from within your word processor. Y ou can aso invoke the file shortcut within
Shorthand by choosing Shortcuts from Shorthand's Main Menu.

. Eda Dachonary Helo
You can invoke your Edi..

File Shortcut by
choosing it from the AltsT

Shortcuts menu.

@ Not

€s

If you want to use function keys as shortcut keysit is recommended that you
combine them with the Ctrl, Shift, and/or Alt key to avoid conflicts with the
Suggestion Window which uses the F1 to F9 keys.

Y ou can specify almost any type of file to be associated with a File Shortcut. For
example if you associate Alt+W with the file "http://www.pcshorthand.com”,
pressing Alt+W will launch your web browser and go to the specified web page.

@ File Shortcuts and Tcl scripts are useful for
adding new functionality to Shorthand.

You can add new menu commands to Shorthand by writing a

Tcl script and creating a File Shortcut to run the script. For

example, see p. 122 for the procedure to add a menu

command to perform a search with pattern matching.
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How to remove a dictionary tab

When you open or create a dictionary, Shorthand creates atab for it at the bottom of the
Main Window. If you don't want to see atab for a certain dictionary, you can remove
the tab by closing the dictionary.

To close adictionary:

o -
I e i T e B el i

]\U ntitled ) gimyl r‘.fhancialf

%

1 Click on the tab of the
dictionary you wish to remove.

& Shorthand

| Eile Dictionary Shorteuts  Help

2 Choose File=>Close.
The tab disappears and file
in the next tab is opened.

=0
Open... Cirl+0
SEVE Cirl+5

o>

Ereferences...
Frintta Eile. .
Bun File Conwverer

Exit

@ When you close a dictionary, you are smply removing its tab from the Main Window;
the file has not been deleted. To permanently remove afile from your hard disk, you
will need to use Windows Explorer (p. 11) to delete thefile.
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How to protect a dictionary from unauthorized

aCCess

Shorthand gives you the option of protecting dictionary files from unauthorized use.
Thisis especialy helpful if you plan on sharing your dictionaries with another user but
want to prevent others from accessing the file. Protecting a dictionary file also prevents
changes to its contents.

To protect a dictionary:

1 Open the dictionary you want to
rename (p. 20). The dictionary's name bepword
should appear in Shorthand's title bar
and be the selected dictionary tab.

55 Shorthand 8.00 [RC2)

- giny1.5PF
T

AutcReplace W Tupedt I

= e s & el I |
Untitled } giryl £ Brancial f
e =

Add..
ety

Bemorve (Caut)

2 From Shorthand's Main Menu, Copy
choose Dictionary=>Protect. The Paste
Protect dialog box appears.

Duphcate

Find.
Search Again

3 Enter the License ID (p. 47) of
the person who may access the
dictionary. If you enter your own
License ID, then only computers
registered with your Shorthand
license will be able to access the
dictionary. If you enter nothing in
the first box, anyone with
Shorthand can access the
dictionary (i.. the dictionary is
unprotected).

W 4B1234567890CDEF

W Show Shoteuts
Enable Links

Prgtect._.

Fie Shoculz  Help

Ins
F2

Alelns

Chl+F
Fi

4 Click OK to

apply the
protection to

AN

Enter LICEMSE 10 of the perzon alowed to access this
tile [only the first 16 characters are significant; enter a
blank. string to allow anyone to read the file]:

Enter up to 3 lines (2.9, vour coppright information) that
will appear in the Dictionarny Info dialog box

I tedical Dictionary V\

the active
dictionary

X Cancel

il

? Help

You can enter anything
you want in these 3 lines;

| by John Smith

| &

these lines are displayed
when you choose
Dictionary=>Info.
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Where is my Registration ID?

When you purchased a Shorthand License, you should have received a personalized
Registration ID with instructions on how to enter it into your copy of Shorthand. Y our
Registration ID has 3 parts: the USER ID, the NUMBER OF USERS and the

LICENSE ID.

To view your Registration 1D information:

By Shorthand

File Dichonay  Shortcuts

Help
Contents

From Shorthand's

Main Menu choose
Help=>About. The
About box appears.

Waitarty and License Agresment
Licenzing and Regstration
Dirder Form

Shahshcs....

.

About,

About Shorthand for Windows

Your USER ID consists of your
name or company name plus a
date string. If the USER ID has
someone else's name on it, you
may be using an illegal copy of
Shorthand; to maintain the
security of your word lists, you
should get a Registration ID with
your name on it.

Shorthand for Windows ™
Version 9.00

Copyright € 1334-2000 OfficeSaft LLC. All Rights Reserved.
517 Cobb Court, La Puente, T 91746
Wweb Site: http:/Awaw, peshaorthand. com

SHAE.OLL © 1999-2000 L & A Enterprizes, Inc.

Thiz is a Licensed Copy of Sharthand.
Contact SficeSaft at help@peshorthand.com i your name or

ompany name does not appear below.

The NO. OF USERS

The LICENSE ID is an
identification number linked to
the USER ID and consists of
18 characters (A-F, 0-9, there
are no letter O's or letter I's).
Shorthand stores the LICENSE
ID in dictionary files you create
S0, again, it is important that
you always run Shorthand
licensed with your Registration
ID.

Thiz copygnf Shorthand iz licensed for use by
John Smith 2001.01.23

(usually the number "1")
indicates the number of

License |D: ABCD1234567390E

Copy

Click the Copy button
to copy your

users allowed to use this

Registration ID.

% Reaizter

@ Licensing Info

Registration ID to the
clipboard where it

can be pasted to

another application.
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How to open a dictionary with a single keystroke

Y ou can open adictionary with a single keystroke by creating a File Shortcut for that
dictionary. Follow the procedure on p. 42 to create afile shortcut and specify the
dictionary file to open in step 3.

How to launch external applications with a single

keystroke

Y ou can launch a Windows application with a single keystroke by creating a File
Shortcut. Follow the procedure on p. 42 to create a file shortcut and specify the filename
of the Windows application to launch in step 3.

How to prevent a keyword from expanding
Press Esc right after you type the keyword.

How to replay an expansion

If, for some reason, an expansion was not done correctly you can replay the last
expansion by pressing the Shorthand Hot Key (p. 49) in your word processor to bring up
Shorthand's Main Window, right click on the Text to Type box, select "Restore Last"
then click the Type It button.

@ Choosing the right keyword can make using
Shorthand much more efficient.

To prevent unwanted expansions, avoid abbreviations that are

valid words (e.g. dont use pat as an abbreviation for

patient ). See p. 130 for additional tips.

@ You can use Shorthand with other word expanders
by choosing the right keywords.
It is possible to use Shorthand with other word expanders if
you are careful to avoid having the same abbreviations in both
expanders. One solution is to add a prefix to your keywords;
for example you can add a / to all your Shorthand keywords
so your Shorthand abbreviations won t conflict with Microsoft
Word s AutoCorrect.
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Hot Key

The Hot Key is the keyboard command to access the Shorthand Main Window. By
default, Shorthand assigns F10 as the Hot Key. To change the Hot Key:

& Shorthand

| File Dictionary Shortcuts  Help

e
1 From Shorthand's Main Open... Cirl+0)
Menu choose Save Cirl+5
File=>Preferences. The Seve As..

Preferences window \ Close
appears.
PP

Printta Eile...
Eun File Converter

Exit

Shorthand Preferences - C:ASHORTHNDAS horthnd.igg .
2 Click on the Hot Key button. 1. Operation iZ. Displa_',l! 3 File Shortcutsl 4 AutoReplacy The aSSIgned
The Select Shortcut Key dialog Hot Key is

box appears. displayed here.

Mext Key Typed

“Keystroke Options

PRGN

Paste Key |
FPauze |10 | mzec after every !1 t; keystrokes

v Weiify Target Window Receives Keystiokes

|Shift+lres

3 Inthe Next Key Typed window, press the
keystroke (e.g. Alt+T) you want assigned as the
new Hot Key. The Select Shortcut Key window

The next key typed will be the
key assigned to the shortcut

% Cancel I appears and shows the key you just typed.
: 4 Click the OK button to accept

the keystroke. The Preferences
window reappears.

Select Shortcut Key

" OK
I X Cancel
T ~—l If you want to change the

T Lol gk T Shit 7 Help I || keystroke, click the Next Key

Mest Key Toped £ Typed button to start over.

Copyright © 2002-2005 by OfficeSoft LLC (http://pcshorthand.com). It is illegal to copy any portion of this book.
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5 Verify your new Hot Key

is displayed here. 6 Click OK to save your

changes and return to
Shorthand Preferences - C:ASHORTHNDAS horthnd. i Shorthand.

1. Operation |2. Displayl % File Shnrtcutsl 4 AutDHEDIacel A Linksl

Keystroke Options }'

Hat Key | AltsT
Paste Key | IShifl+Ins X Cancel |
Paysze (10 = msec after every m keystiokes ? Help |

[V Werify Target ‘Window Receives Keystrokes

Do not use function keys F1 to F9 as keyword shortcut keys as it may conflict with
the Suggestion Window which (unless you change this) uses the F1 to F9 keys to
select a suggestion.

The Hot Key only works if the Shorthand program is running and the Shorthand icon
appears in the system tray (p. 13).

The Hot Key is not the only way to bring up Shorthand's Main Window. Alternative
ways of bringing up the Main Window are clicking on the Shorthand system tray
icon (p. 13) or clicking your right mouse button over the Suggestion Window (p. 56).
Note that the Type It button is enabled only if you bring up the Main Window with
the Hot Key. The Type It button is disabled if you click on the Shorthand icon or
system tray icon because Shorthand doesn't know to which window to perform the
expansion.
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AutoReplace

When AutoReplace is turned on, Shorthand will automatically detect and replace
keywords as you type in your word processor. Since thisis usually what you want
Shorthand to do, always make sure AutoReplace is enabled before using Shorthand.

To make sure AutoReplace is activated:

1 Bring up Shorthand's Main
Window (p. 13).

2 Make sure the AutoReplace
box is selected.

iy Shorthand H=]

File Dictionary  Shortcutz Help

Keyward AutoReplace W ol I

]

Test to Type

Dictiorary: E?!F_“ Di!i _‘@‘J

Shartcut Dezcription
as soon as possible
ats The apples aon the tabletop appeared: Ple
bday date of birth
chioicelaw choice of law text
equit Equitable Bank
.jmn |=|q|nr\|n [ T— i aweal _"_!

\Untitled Ly ;ffinancialj
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Expansion speed

Word processors are designed to accept input from human typists. A common problem
is when Shorthand inserts text far too fast for your word processor to process which can
result in doubled first characters, missing characters and parTIAL caps. If thisoccurs,
the solution is to slow down Shorthand to give your word processor time to keep up with
Shorthand.

To change Shorthand's typing speed:

& Shorthand

| Eile Dictionary Shoreuts  Help

e
1 From Shorthand's Main Open... Cirl+(0)
Menu choose Save CHl+5
File=>Preferences. The Save As..
Preferences window \ Close
appears.
PP Preferences..
Printto Eile...
Eun File Conwverter
Exit

Shorthand Preferences - C:ASHORTHNDAS horthnd.ini

1. Operation ig. Displayl 3. File Shortcuts | 4. AutoHepIacel a Linksl

Keystroke Options

Hotkey | [FI
Paste kep i IShift+Ins x —eiE |

—
Pause ‘W mzer after every 40 = fepstiokes ? Help
W WerifyA anget Window Receives Keystrokes

2 Enter the delay in milliseconds 3 Enter how often Shorthand
(1/1000t of a second) applies the delay in step 2.
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@ Notes

A setting of 100 msec every 3 keystrokes means Shorthand will pause 100
milliseconds (100/1000th of a second) after every third keystroke it inserts.

A setting of 20 msec every 1 keystr okes should work with most newer computers. If
you observe missing characters in the expansion, try increasing the delay to 50 msec
(or higher) every 1 keystrokes.

If changing the delay doesn't seem to help, another application may be interfering
with Shorthand. Try identifying and shutting down all programs that monitor
keystrokes; examples are spell checkers, clipboard utilities, mouse utilities (e.g.
Power Toys) and built-in word expanders such AutoCorrect in Microsoft Word.

Setting the delay to 0 msec means Shorthand will simulate keystrokes at full speed
and is not recommended.

@ Use the {@PAUSE} tag to insert delays when
expanding large amounts of text.

Most word processors need to redraw its window when text

scrolls off the bottom of the page. For this reason, you should

embed {@PAUSE} tags (p. 72) in long forms with a large

amounts of text.

@ Other programs can affect Shorthand s

expansion speed.

When Shorthand pauses, Shorthand will not wake up until
other applications have completed their activity. Unless you
have a fast computer, it is recommended you do not run any
application that works in the background; examples are:
timers, automatic email or news notifiers, mouse/keyboard
utilities, the Microsoft Office Toolbar and spell checkers.
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Shorthand provides two methods for inserting text to your word processor: Smulate
Keystrokes and Smulate Clipboard Paste.

The Smulate Keystrokes method (the default method) synthesizes a full keystroke for
every character that needs to be inserted to your word processor. This method works

well with most applications.

The Smulate Clipboard method first transfers the Shorthand text to the clipboard and
then ssimulates a Shift+1ns keystroke to paste the text from the clipboard to your word
processor; use this method if you usually need to transfer large amounts of text. Note
that Simulate Clipboard works if only pure text are to be inserted; if your Shorthand
code contains { @KEY} or { @PAUSE} tags, Shorthand will use the Simulate

Keystrokes method.

To select the text transfer method

1 From Shorthand's Main Menu
choose File=> Preferences. The
Preferences window appears.

& Shorthand

| Eile Dictionary Shodcuts  Help

=0

2 Select the Text
Transfer method.

Open... Cirl+0
Save Cirl+5
Save As..

Close

Ereferences...
Frintta File...

Shorthand Preferences - C:ASHORTHNDAShorthnd. ini

1. Operation ig. Displayl 3. File Shortouts | 4. AutoHepIacel 5 Linksl

 kepstroke Options

Hat Key | |F1o
Paszte Key i IShift+Ins
Pausze 10 | mszec after every | 1 3, keystrokes

W “erify Target Window Receives Kepstiokes

| x Cancel I
? Help |

~Sound Option
[~ Beep'when Hot Key Pressed
¥ Eeep'when Typing Empty Text Sting

I™ BeepAfter Teu Transfered

T ext Transfer Method
i Simulate Clipboard Paste if Test Only
i+ Simulate Keystrokes
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Adding keywords with the Alt+Ins command

Shorthand allows you to quickly add new keywords to the active dictionary by pressing
Alt+Ins from your word processor.

To enable the Alt+Ins feature:

& Shorthand

| File Dictionary Shortcuts  Help

e
1 From Shorthand's Main Open... Cirl+(0)
Menu choose Save CHl+5
File=>Preferences. The Save As..
Preferences window \ Close
appears.
PP Preferences..
Printto Eile...
Eun File Conwverter
Exit

2 Choose the
4. AutoReplace tab.

Shorthand Preferences
1. Operation i 2 Displayi 3. File Shortcut

3 Make sure the Links |

4 AutoReplace [D.

Enable AutoReplace ~AutoReplace Dptions :
box is selected. v Enable AutoReplace : 5
[v Enable Automatic Kepword Completion X Cancel |
[ Beep DT. Keyword - - 2 Hel |
[¥ Use Shift+Enter to expand kepword immediately L
¥ Uszse Ctrl+ f Jout expanding keywor
4 Select this box to ¥ Use Alt+Ins to add current word to dictionary
enable the Alt+ins
feature.
~AutoReplace Suggestion Window
¥ Show Hint Window When Keyword Detected
¥ Show Suggestion Window
5 Click OK to save

your settings.

? The Alt+Ins command works only if AutoReplace (p. 51) is enabled.
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Suggestion Window

The Suggestion Window displays a list of up to nine suggestions for the word you just
typed. You can expand an entry by selecting from the list with the F1 to FO keys.

The first line

Shorthand How-to Guide

tracks your
keystrokes as

you type.

To reposition the window, click
and drag the title bar.

Ehmﬂﬂ

d

[FI] dsel= desl

[F2] daxeeing = danring
[F3] datsl = {ESHORTDATE]

[F4] dated = curent long date [F7] detam = dream

delinately = d:ruﬁh.-]}r [FE] detente = dSlepr
?-ﬂ delete3 = (@DELETELINE)  [F9] develope =develop

N

/

To resize the
window, click and
drag the borders

expand a suggestion.

Up to 9 suggestions are displayed. Click this button(or click your
Use the F1 to F9 keys to select and right mouse button anywhere

in the window) to display a
popup menu.

V

Select this command to hide the
Suggestion Window. The window
reappears when you bring up the
Main Window or type a keyword.

Bring Lp b ain Wwindow
Hide Temporarily

v 3 Columns

¥ 1 Column

window.

Select the number of columns
displayed in the Suggestion

Preferences...
About..,
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To enable the Suggestion Window:

1 From Shorthand's Main Menu Shorthand

choose File=>Preferences. The | Eile Dictionary Shorcuts  Help
Preferences window appears. e

Open... Ctrl+0

Save Cirl+5

Save A

Close

Ereferences...
Frintta File...

2 Choose the
4. AutoReplace tab.

Shorthand Preferences

1. Dperation i 2. splay I 3. File Shortcuts 4. AutoReplace [B. Links i
3 Make sure the ~AutoReplace Options :
Enable AutoReplace —p € ¥ Enable AutoReplace

box is selected. ¥ Enable Automatic Keyword Completion x Cancel I
[ Beep otl Kepword - - 2 Help |
¥ Use Shift+Enter to expand keyword immediately 2

[v Use ChulsSpace to inzert a space w/out expanding keyword

¥ Use Alt+Ins to add current word to dictionary

4 Select the Show

Suggestion Window
check box ~AutoReplace Suggesthion Window

¥ Sho, i I ‘When Keyword Detected
¢ ¥ Show Suggestion Window [Options]
M ¥

5 Click [Options] if you wish
to change the Suggestion
Shortcut keys.

? Shorthand displays the Suggestion Window only if AutoReplace (p. 51) is enabled.

@ You can change the size of the text displayed in the
Suggestion Window.

If the text in the Suggestion Window appears too small or too

large, you can change the fonts as well as the background

window color. See p.61 on how to do this.
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Hint Window

To enable the Hint Window:

Shorthand can display a small
Hint Window whenever you type
a recognized keyword. The Hint
Window displays the associated
text that will be inserted in your
word processor if you press

[ , ‘5] or any

punctuation mark. To prevent
expansion, press [ .

W Microsoft Word

asap

as soon as possible

We need the project done asap|

Shorthand How-to Guide

1 From Shorthand's Main Menu
choose File=> Preferences. The
Preferences window appears.

2 Choose the

4. AutoReplace tab.

=0
Open...
Save

Ctrl+10
Ctrl+5

Save A

Close

& Shorthand

| File Dictionary Shorcuts  Help

Ereferences...

Frintta File...

Shorthand Preferences

3 Make sure the
Enable AutoReplace
box is selected.

—pC

4 Select the Show
Hint Window When
Keyword Detected
check box

AutoReplace Options

1. Operation I 2 Displayi 3. File Shortc

Y 4. AutoReplace

5 Links I

¥ Enable AutoReplace

[v Enable Automatic Kepword Completion

[ Beep on Keyword

[¥ Use Shift+Enter to expand kepword immediately

| Uze Chl+Space to insert a space w/out expanding keyword

¥ Use Alt+lns to add current word to dictionary

X Cancel

2 to |

? Help
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Automatic Keyword Completion

Automatic Keyword Completion is helpful if you have trouble remembering keywords.
When Automatic Keyword Completion is enabled (the default), Shorthand will display
the nearest matching keyword whenever you type two or more commeas after a word.
For example if you have the following keywords:

Keyword Text to Type

tyl Thank you very much
ty2 Thank you
ty3 Thanks

If youtypety,, ("ty" followed by two commas), Shorthand’s Hint Window (p. 58) and
Suggestion Window (p. 56) will display the first keyword that begins with "ty" whichin
our example isthe keyword for "Thank you very much." If youtypety,,, ("ty"
followed by three commas), Shorthand will match thisto t y2, the keyword for "Thank
you." Similarly,ty,,,, (theword“t" followed by four commas) will be matched to the
keyword t y3 which is the keyword for "Thanks".

By default, Automatic Keyword Completion is turned on; to disable it:

;_ETE_ Dictionary Shorcuts  Help
[ e
1 From Shorthand's Main Open... Cirl+0
Menu choose Save Crl+3
File=>Preferences. The Seve As..

2 Choose the

4. AutoReplace tab.

Preferences window \ Close
a IS.
ppears Ereferences...
Frintto File...

Bun File Corwverter

Exit

3 Make sure the
Enable AutoReplace
box is selected.

4 Deselect (uncheck)
this box to disable
Automatic Keyword
Completion.

Shorthand Preferences

1. Operation | 2. Display | 3. File Shultcu 4 AutoReplace [

Links I

~AutoReplace Options

v Enable AutoReplace

C:E:Ea_l:nle Automatic Keyword Qn@

[~ Beep on Keyword

[+ Usze Shift+Enter to expand keyword immediately

x Eancel’l
? Help |




60 Shorthand How-to Guide

Sound options

For touch typists, Shorthand can give audible feedback on what it is doing so you don't
have to look at the screen.

To access Sound Options:

1 From Shorthand's Main Menu EE_’:_:: Shorthand

choose File=>Preferences. The | Eile Dictionary Shorcuts Help
Preferences window appears. MNew

Open... Ctrl+0

Save Cirl+5

Save A

Close

Ereferences...
Frintta File...

Shorthand Preferences - C:ASHORTHNDAS horthnd.ini
1. Operation ig. Displayl 3. File Shortcuts | 4. AutoHepIacel a Linksl

F.eystroke Options

2 Select the _ Hokey | [0
appropriate options. Paste Key i |Shift+lns X c.ance||

Pause 10 = mzec after every |‘I g kepstrokes ? Help |

W Werify Tanget Window Feceives Keystrokes

—Sound Optian
[~ Beep'when Hot Key Preszed
[¥ Beep'when Typing Empty Test Sting
[~ Beep After Test Transferred

m tathod

i Simulate Clipboard Paste if Test Only
* Simulate Keystiokes

@ If you are not hearing any beeps after you activate the options for audible warnings, the
speaker volume may be at minimum or your speakers may be on MUTE. You can
change volume through the Volume icon on the Windows system tray. To change the
tone of the audible warnings, go to Windows Control Panel and choose the Sounds icon.
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Fonts and colors
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To improve readability, you can change the window colors and fonts of some of the text
displayed by Shorthand. Y ou can change the following:

The text fonts displayed in the text input boxes.
The text fonts displayed in the Dictionary list in the Main Window.
The text fonts displayed in the Suggestion Window.

The color of the Main Window.

The color of the keywords in the Dictionary list in the Main Window.
The color of the Suggestion Window.

To access the font and color options:

1 From Shorthand's Main Menu horthand
choose File=>Preferences. The | Eile Dictionary Sharcuts  Help
Preferences window appears. e
Open... Cirl+0
Save Cirl+=
Save As..
2 Choose the Display Close
tab. Preferences..
Frintta File...
Shorthand Pyeferencor
( —Font and Color Options ] ; :
3 Click on the Editor Font i Main Window Color | X Cancel |

appropriate button.

Dictionary List Font |

‘? Help |

Dictionary List Keyword Color |

Suggestion Window Funtl

Suggestion Window Color |

Close Options

[v AutoSave

[¥ Do Mot Confirm Exit

@ Notes

Selecting a fixed spaced font such as Cour i er makesit easier to spot unwanted

spaces in your text.

The above options only affect how text appears insde Shorthand and do not affect

how Shorthand transfers text. See p. 70 to control how the text appears in your word

jprocessor.



62

Shorthand How-to Guide

Automatic File Saving

Shorthand automatically saves the active dictionary whenever you switch to another
dictionary. In addition, if automatic file saving is enabled (the default), Shorthand will
also save your file whenever you do any of the following:

Click on the Hide button.

Exit Shorthand

We suggest you keep automatic saving enabled as this feature may prevent data loss if
your computer crashes or you accidentally turn off your computer.

? However, if you have avery large dictionary with tens of thousands of entries, it may
take along time (severa minutes) to save the file every time you click the Hide button
S0 you may want to disable automatic file saving.

To disable automatic saving:

1 From Shorthand's Main Menu Shorthand

Shorthand Prefer. ces

1. Operatiory” 2. Display t‘

choose File=>Preferences. The | Eile  Dictionary Shortcuts  Help
Preferences window appears. Mew
Open... Cirl+0
Save Cirl+=
Save As..
2 Choose the Display Close
tab.
Ereferences...
Frintta File...

File Shortcuts | 4. AutoReplace i 5 Links I

—Font and Color Options

Editor Font

i Main Window Color |

Dictionary List Font

| Dictionary List Kepword Color | ? Help |

Suggestion Window Funtl Suggestion Window Color |

i Close Options

[ AutoSave [¥ Do Mot Confirm Exit

3 Deselect (uncheck) the
AutoSave box
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How to exit Shorthand without confirmation

When you exit (terminate) the Shorthand application by choosing Files>Exit Shorthand
will display adialog box asking if you really want to exit; this helps you avoid shutting

down Shorthand accidentally.

If you don't want Shorthand to

show the exit confirmation dialog box:

1 From Shorthand's Main Menu
choose File=> Preferences. The
Preferences window appears.

&4 Shorthand

| Eile Dictionary Shodcuts  Help
=0

2 Choose the Display
tab.

Open... Cirl+0
Save Cirl+5
Save As..

Close

Ereferences...
Frintta Eile...

Shorthand Prefersnces

1. Operation '1 File Shortcuts | 4. AutoReplace i 5 Links I

—Font and Color Options

Editor Font i

Main Window Color |

Dictionary List Font | Dictionary List Keyword Color | ? Help |

Suggestion Window Funtl Suggestion Window Color |

~ Close Options

[ AutoSave [¥ Do Mot Confirm Exit

\ 3 Select (check) the

Do Not Confirm Exit box.
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How to use Shorthand on a Network

Warning! Beforeinstalling Shorthand on a network, make sure you have avalid
Shorthand Site License to cover all persons able to use or access Shorthand on your
network; unauthorized use of Shorthand by unlicensed personsis a violation of
copyright laws and may result in severe civil and crimina penalties.

Even though it is possible to install a single, shared copy of the Shorthand program files
on your network and keep each user’s configuration files separate through Shorthand’s
/cfg command line parameter (see Shorthand’ s on-line help: choose Help=>Contents,
click on Advanced Topics then Using Shorthand on a Network), we present below a
simpler solution.

Install one copy of Shorthand for each user

The easiest way to use Shorthand on a network isto ssmply install one copy of
Shorthand per user. The Shorthand program files occupy very little disk space (less than
4Mb). To prevent one user from accessing another’s Shorthand files, each copy of
Shorthand should be installed to a user’ s private folder on the network.

Specify shared dictionaries as linked dictionaries.

Dictionaries that are to be shared among all users should be placed in a public folder on
your network. Shared dictionaries should be loaded into Shorthand as linked
dictionaries (p. 40). In addition, to prevent accidental modification of shared
dictionaries, the shared dictionary files should have a READ ONLY attribute (you can
use Windows Explorer to change afile' s attributes).

Create a private dictionary for each user.

In each user’ s Shorthand program folder, create (p. 18) adictionary to hold the user’s
private word list. For illustration purposes, we will call this dictionary
PERSONAL.SPF. When a user starts Shorthand, Shorthand will open the

PERSONA L .SPF as the active (i.e. main) dictionary and open the shared dictionaries as
linked files. If auser adds a new entry (p. 24), the new entry iswritten to
PERSONAL.SPF. If auser wishesto override (replace) an entry in a shared dictionary,

he/she should:

1. Unload the shared dictionaries by disabling links (see How to enable/disable links on
p. 41),

2. Create the replacement entry (see How to add new entries to a dictionary on p. 24),
and

3. Enablelinks (p.41) to reload the shared dictionaries. The replacement entry will be
saved in PERSONA L .SPF and override entries with the same keyword in shared
dictionaries.
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Chapter 4 Shorthand Tags

Overview

Tags are specia fields that can be inserted in your Shorthand text (i.e. the text you place
in the Text to Type box). Tags represent special functions in Shorthand and alow you to
do things such as:

Insert the current date or time.

Display adialog box to the user and insert the user's response into the Shorthand
text.

Import the contents of atext file.
Pause between characters.
Simulate keystroke combinations such as Shift+F1.

Execute Tcl (Tool Command Language) scripts and insert the result into your
Shorthand text.

The basic syntax of aTagis.
{@tag_name argl arg2 arg3...}

where tag_name is the name of the Tag (e.g. PAUSE to create a short pause) and argl,
argz, arg3 are arguments and options used by the Tag (e.g. number of seconds to pause
for the PAUSE tag).

@ When are Tags evaluated?

When you tell Shorthand to expand a keyword in your word processor, Shorthand first evaluates all tags
that begin with {@INPUT*} (such as {@INPUT]}, {@INPUTTCL} and {@INPUTFILE}). After all @INPUT
tags are evaluated, Shorthand simulates backspaces to remove the keyword in your word processor and
proceeds to insert text to your word processor; the non-input tags (e.g. {QKEY}, {@PAUSE},
{@SHORTDATE}) are evaluated at this time.

Copyright © 2002-2005 by OfficeSoft LLC (http://pcshorthand.com). It is illegal to copy any portion of this book.
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Date/time tags

Shorthand How-to Guide

Shorthand has several tags that will insert the date/time in your Shorthand text.

{ @ NPUTDATE}

{ Q. ONGDATE}

{ @GHORTDATE}

{ @ ONGTI M}

{ @HORTTI ME}

Keystroke tags

Displays a dialog box in which the user can enter a date.
The output can be in short or long date format.

Inserts current date using the Windows long date format.
Example output: Saturday, July 14, 2001

Inserts current date using the Windows short date format.
Example output: 07/14/01

Inserts current time using the format hours:minutes:seconds.
Example output: 11:43:05 AM

Inserts current time using the format hours:minutes.
Example output: 11:43 AM

Shorthand provides several tags for ssimulating special keystrokes (e.g. F1) and keyboard
combinations (e.g. Shift+Ctrl+F1).

{ KEY key}

{ GXEYDOWN key}

{ @GEYUP key}

{ @PAUSE}

Simulates a complete keystroke.
Example: {@KEY shift+f10} simulates
Shift+F10

Simulates the pressing (holding down) of a key.
Example: This tag simulates holding down the
shift key: {@KEYDOWN shift}

Simulates the release of a key.
Example: This tag simulates releasing the shift
key: {@KEYUP shift}

Inserts a 1 second pause before inserting the
next character.
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File tags
Shorthand has atag to import the contents of atext file into your Shorthand text.
{ @ NPUTFI LE fil enane} Inserts the contents of filename. The
file may contain Shorthand tags.
Input tags

Shorthand provides several tags for displaying dialog boxes to the user; the user can type
text into the dialog box which will be inserted in your Shorthand text. With input tags,
you can use Shorthand to show a series of "question and answer" dialog boxes to create
custom reports.

{@NPUT pronpt} Displays a dialog window for entering
text. The prompt is displayed at top of
the window.

{@NPUT |ist_itens} Displays a dialog window showing a
selectable list of items.

{ @ NPUTDATE} Displays a dialog window for selecting a
calendar date.

{ @ NPUTMSG nessage} Displays a message.

Miscellaneous tags

{ GNOSPACE} Prevents a space from being added
after a keyword is expanded.

{ @ELETELI NE} Deletes an entire line of text.

{ @GREM coment } Adds comments (remarks). This tag will
not be typed out.

{ Q. EFTBRACE} Inserts a left brace {

{ @RI GHTBRACE} Inserts a right brace }

{ @ NPUTTCL} Executes a Tool Command Language

(Tcl) script.



68

Shorthand How-to Guide

How to simulate keyboard commands

Y ou can use Shorthand's { @KEY} tag to simulate keyboard commands
recognized by your word processor. It isimportant to remember that
Shorthand can only simulate keystrokes and has no notion of what the
commands do in your word processor. For example, you can use
Shorthand to ssimulate the keyboard command turn bolding on/off but the
text in Text to Type box will not be displayed in bold.

The syntax of the { @QKEY} tagis:

{@KEY key n}

where key is name of the keystroke you wish to simulate and n is the
number of times to repeat the keystroke. For example, { @KEY f} will
simulate pressing and releasing the [E] key and { @KEY home 3} will
simulate the key 3 times.

Here are some examples of { @KEY} commands:

{ @XEY enter}

{ @EY 1}

{@EY !} or { @EY shift+1}
(assumes that ! is on the 1 key.)

{ @EY f 10}

[ALT] +[7] {GKEY al t +f 7}

[crr] +[E] {@KEY ctrl +e}

[snr1] +[A] { @EY shi ft+a}

[crr] + [ALT] +[E] { @KEY ctrl +al t +e}

{ @EY del }

{ @EY end}

{ &XEY pgup}

{ &XEY pgdn}

{ @XEY space}
{ GXEY t ab}

=
>
S

{ @XEY esc}
BACKSPACE) { &EY bksp}
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{ &EY up}

{ @XEY down}
{ @EY | eft}
{@XEY right}

on main keyboard { EY +}
on numeric keypad ~ { @EY NunPad+}
on main keyboard { &EY [/}

onnumeric keypad ~ { @EY NunPad/}

{ (left brace) { @EFTBRACE}
} (right brace) { @GR GHTBRACE}
Examples

In most Windows applications, pressing Ctrl+Shift+L eft Arrow selects the previous
word so the following Shorthand code can be used to delete the previous word:

{@EY Ctrl+Shift+Left}{@EY del}

Most Windows applications also have a Save command under a File menu which you
can access by first pressing Alt+F followed by pressing S. So the Shorthand code to
save afile would be:

{@EY Alt+F}s
The following pages contain more examples on how to use the { @KEY} tag.

@ Knowing your word processor s keyboard shortcuts
will help you use Shorthand more effectively.
To find the keyboard commands for your word processor, bring
up your word processor's on-line help and search for
"shortcuts”. Word processors such as Microsoft Word and
WordPerfect allow you to define keyboard shortcuts to apply
different font styles, create tables, insert locked spaces, efc.
Once you know the keyboard command for a particular
function (e.g. enable/disable bold face) you can use the
{@KEY} tag to simulate that command with Shorthand (see p.
70 for an example).

69
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How to use the {@KEY} tag to change font styles

Y ou can use Shorthand's { @KEY} tag to simulate keyboard commands recognized by
your word processor to change how the text inserted by Shorthand appears in your word
processor.

Example problem

How do | use Shorthand to simulate superscripts to type out the symbol for degrees
Fahrenheit, °F, in Microsoft Word?

Solution
Create a new Shorthand entry (p. 24 ) with the following data:

Keyword: [ df |

Text to Type:
| {@EY ctrl+shi ft++}0{ @EY ctrl +shi ft ++}F \

Test the entry

1) Make sure Shorthand is minimized. If any of Shorthand's dialog boxesis visible
closeit and click on the Hide button in the Shorthand Main Window.

2) Bring up Microsoft Word and type:

98 [acg df [sPace .
The result should be: 98 F

How it works
Here's an explanation of the Shorthand code in the Text to Type box:

to turn on the superscript font
style in Microsoft Word.

0 Types out "0" (which will appear
in superscript font).
{ @EY ctrl +shi ft++} Simulates [crec] +[suiFT] +[£]

to turn off superscript.

F Types out "F" in normal font.

@ Y ou can use this same technique to ssmulate other fonts; for example, { @KEY Ctrl+B}
will enable/disable bold fonts in Microsoft Word. See your word processor's
documentation for the keyboard commands to change fonts.
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How to use the {@KEY} tag to insert special codes

such as locked spaces

Y ou can use Shorthand's { @KEY} tag to simulate keyboard commands recognized by
your word processor to insert special symbols or characters.

Example problem

In Microsoft Word, how do | use Shorthand to create a entry for "mm" (millimeter) with
alocked space before "mm™? A locked space (also known as a non-breaking space) tells
the word processor to keep two words on the same line.

Solution
Create a new Shorthand entry (p. 24) with the following data:

Keyword:
Text to Type:
| { @EY bksp}{ @EY ctrl +shift+space}nm \

Test the entry
1) Make sure Shorthand is running and minimized (click Shorthand's Hide button).

2) Bring up Microsoft Word.

3) Inyour word processor, type: 5 mm :
The result should be: 5 mm

with alocked space between 5 and mm .

How it works
The Microsoft Word command to insert alocked space is Ctrl+Shift+Space (i.e. while
holding down the and keys, pressthe SPACE BAR). Here's an explanation
of the Shorthand code in the Text to Type box:

{ @XEY bksp} Simulate a BACKSPACE to delete the

previous character. This is necessary to
prevent double spaces.

{@EY ctrl +shi ft +space} Simulates Ctrl+Shift+Space to insert a locked
space in Microsoft Word.

nm Types out "mm".
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How to pause Shorthand in the middle of an

expansion

Y ou can use the { @PAUSE} tag to insert a delay/time |apse between keystrokes or after
akeyboard command to allow the computer to process the command. Complicated
commands (especially those that launches applications or displays new windows) may
not be properly processed if the computer is deluged with dozens of keyboard commands
occurring in afew seconds.

The syntax for the { @PAUSE} tag is:
{@PAUSE n}

where n is the number of seconds to pause. For example, { @PAUSE 0.5} will tell
Shorthand to pause half a second. If you don't specify n, Shorthand will pause 1 second.
If nislarger than 10, Shorthand will pause only 10 seconds at most.

Example problem

How do | create a keyboard shortcut to move the cursor to the next occurrence of the
word "INPUT:" in aMicrosoft Word document?

Solution
Create a new Shorthand entry (p. 24) with the following data:

Keyword: [find_input ]  Shortcut: [CrT+Alt+ ]

Text to Type:
| {@XEY al t +e}{ GEY f}{ @AUSE} | NPUT: { @PAUSE} { @XEY al t +f} \

Test the entry
1) Make sure Shorthand is running and minimized (click Shorthand's Hide button).

2) Bring up Microsoft Word and create or open a document that contains several
instances of the word "INPUT:".

3) In Microsoft Word, press. Ctrl+Alt+l

Y ou should see Word bring up the Find dialog box, search for the next instance of
"INPUT:" then close the Find dialog box.
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How it works
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Shorthand uses Word's Find function to search for INPUT; here's an explanation of the
Shorthand text in the Text to Type box:

{ @XEY al t +e} Simulate Alt+E to choose Edit from Word's
main menu.

{ &XEY f} Chooses Find from Word's Edit menu.

{ @PAUSE} Pauses 1 second to give Word time to display
the Find and Replace dialog box.

I NPUT: Types out "INPUT:" in the Find what box.

{ @PAUSE} Pauses 1 second to give Word time to update
the Find what box.

{ @XEY alt +f} Chooses the Find Next button to start the
search.

@ Always include an {@PAUSE} tag after any command
that redraws or refreshes your screen.

Windows needs time to refresh your screen so, if you are using

Shorthand to do such things as switch windows, open a dialog box

or access a menu, you should have an {@PAUSE] tag after the

command to give time for Windows to refresh the screen.




74

How to insert the current date and time

Example problem

Shorthand How-to Guide

How do | create a Shorthand entry to type out the following sentence:

The patient was admitted on (today's date) at (current time).

Solution

We use the { @QLONGDATE} and { @SHORTTIME} tags to display the current date
and time. The techniques shown in this section apply as well to the other date/time tags

(p. 66).

Create a new Shorthand entry (p. 24) with the following data:

Keyword:
Text to Type:

| The patient was adnitted on { @ONGDATE} at { @HORTTI ME}.

@ Shorthand uses the
Windows Date settings to display

Test the entry
1) Make sure Shorthand is minimized. If any of Shorthand's dialog

can change the Date style as Shorthand Main Window.

follows: go to the Windows Control

Panel, choose Regional Settings, | 2) Bring up your favorite word processor.

choose Date. You will need to
restart Shorthand to apply the new

3) Inyour word processor, type: ti nme2 followed by :

style. time2 should be replaced with something like:

How it works

Here's an explanation of the Shorthand code in Text to Type box:

The patient was
adm tted on

Types out "The patient was admitted on"

{ @ ONGDATE} Types out the current date using the Windows
Long format.

at Types out "at".

{ GBHORTTI ME} Types out the current time in hour:minute

AM/PM format.

Types out a period.

The patient was admitted on Saturday, February 10. 2001 at 3:45 PM.
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How to ask for a date from the user
Y ou can use Shorthand's { @I NPUTDATE} tag to display adialog box to retrieve a date

response from the user.

The syntax of the { @QINPUTDATE} tag is:
{@INPUTDATE prompt @LONG }

where prompt is the question to be displayed at the top of the Input dialog box.
"@LONG" isan optional argument. If "@LONG" is present, the Windows Long Date
format will be made the default selection; if @LONG is not specified, the Windows

Short Date format is used.

How to use {@INPUTDATE}

The { @INPUTDATE} tag works just like the { @INPUT} tag (p. 76) except that
{@INPUTDATE} will only accept avalid date.

When Shorthand encounters an { @INPUTDATE} tag, Shorthand will display adialog

box to get a date from the user:

You can type in a new date in this box or press
one of these keys:

to go to the next day.

to go the previous day.

to go to today's date.

to go to the first day of the current
month or the first day of the previous month.

to go to the last day of the current
month or the last day of the next month.

to go the first day of the current year or
the first day of the previous year.

to go the last day of the current year or
the last day of the next year.

| 31172001 iﬂd b H first, end of MaontH

Press the Enter key or
click the Next button
when done

Click the calendar button to
browse through a calendar

Shorthand Input Field #1
Enter date of birth

+,- change day; T Today

LR firgt, end of reaR — e
Select D ate Shyle: i estar

1. Thursday, March 01, 2001 @\ Frevien |
&+ 2 31/00 -

x Cancel |

? Help |

Select the date format. You can
change the format in the Windows
Control Panel, Regional Settings.
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How to get input from the user

Y ou can use Shorthand's { @INPUT} tag to display adialog box with a question and
retrieve the user's answer. By using a series of { @QINPUT} tags you can create a
"questionnaire” to guide the user in entering needed information.

@ When are {@INPUT} tags
processed?
Shorthand evaluates all {@INPUT}
tags before inserting any text into
your word processor. This means
that if the user types in an
{@INPUT} tag (or any other
Shorthand tag), these tags will be
recognized and processed by
Shorthand. But this also means
that you cannot use an @INPUT
tag to change Shorthand's
behavior once expansion has
already started.

Solution

The syntax of the { @INPUT} tag is:
{@INPUT prompt @WANTRETURNS}

where prompt is the question to be displayed at the top of the Input
dialog box.

@WANTRETURNS is an optional argument and controls what
happens when you press the key in the input window. If
@WANTRETURNS is present, pressing will create a new
line. If @WANTRETURNS s not present, pressing is
equivalent to clicking on the NEXT button.

Example problem

How do | use Shorthand to type out the following boilerplate text?
Name: (customer_name)
Address: (customer_address)

Telephone: (customer_phone)

Create a new Shorthand entry (p. 24) with the following data:

Keyword: [cust1

Text to Type:

initial}
Addr ess:
code,

Tel ephone:

Nane: {@NPUT Custoner's |ast nane,
[evrer]

{ @ NPUT Number,
count ry}

({@NPUT enter area code})-{@NPUT enter
t el ephone nunber}

first name, mddl e

street nane, city, state, zip

e

Test the entry

1) Make sure Shorthand is running and minimized (click Shorthand's Hide button).

2) Bring up your word processor and create or open a new document.

3) Inyour word processor, type: cust 1 [

4) Shorthand displays a dialog box asking you for the customer's name. Enter the
customer's name and click on the Next button or press :
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When done, Click the Next
button or press the Enter
key.

Shorthand Input Field #1

customer's last name. tirst name,
middle initial

Smith, John S|

/v -—j— Hestart
Enter the customer's namein |~ @, Preview |

this box. Press Ctrl+Enter to

insert a new line. X Carcel |
? Help |
|

Qndnl [t | i:-'\:'.r.l.’!'l _E'-:.'.tel Select&lli

Ctil+Enter = new line; Cirl+Tab = tab

5) Shorthand displays adialog box asking you for the address. Enter the address on one
line. If you wish to enter multiple lines, you can press Ctrl+Enter to create a new line.
When done, click on the Next button or press :

6) Shorthand displays a dialog box asking for the area code. Enter the area code and
click Next button or press :

7) Shorthand displays a dialog box asking for the phone number. Enter the phone
number and click the Next button.

8) Shorthand displays the Text to Type dialog box showing a preview of the text that
will be inserted into your word processor.

Shorthand Text To Type

Name: Smith, John 5.
Address: 12 Main St CA 91107
Telephone: {(818)-123-4567

You can freely edit
the text if you want to
make changes.

-]

it | {0 e | t> Restait .ﬁjj X ﬂ ‘
Use Cil+Enter ta create g/MBw line; Cir+T ab ta ent abs
/ A\
Click Type It to Click Restart to start Click the Cancel button
transfer the text to your over from the to abort and return to

word processor. beginning. your word processor.
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How to display user-selectable pick lists

Pick lists are an extended feature of { @QINPUT} tags wherein alist of selectable items
will appear in adialog box; the user's selection(s) will then be reported back to
Shorthand.

The syntax for the { @INPUT} tag for pick listsis:

{@INPUT prompt options @SEP="sep" @SINGLE
iteml1
item2

itemN
}

where:
prompt is the text displayed at the top of the dialog box
options are optiona arguments and can be one or more of the following:

@SEP="sep specifies the separator string. If the user selects more than one item, the
items will be separated by sep (note that sep can contain spaces and must be enclosed
in double quotes"). If @SEP is not specified, Shorthand uses ", " as the default
separator.

@SINGLE specifies that only one item can be selected. If @SINGLE is not present,
the user can select one or more items.

@GROUP will make items that begin with an asterisk "*" non-selectable. Thisis
useful for adding subheadings or item breaks (i.e. blank lines between items).

@GROUPBOLD isthe same as @GROUP except that the subheadings will be
displayed in bold.

@GROUPPRINT isthe same as @GROUP except that the subheadings will be
inserted in the output if at least one of its sub-items is selected.

@AUTONUMBER adds a number to each item so you can easily jump to an item by
typing a number.

inputl, input2 ... inputN are theitemsin the pick list. Note that the inputN text must
be placed on separate lines. For example, the following Text to Type:

{@NPUT Enter paper size[arr]
8.5 x 11[ave
8.5 x 14 e

5 x 8. 5[eR|
}
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will display the following dialog box:

Enter paper size
Use the search box to > Hewt

quickly find items in long I ——T = &£ Back

lists. I
[l 85x1 3 Restart
(185x14 _—I
To make a selection, /'D 5x8.5 &, Preview I
simply check the R I
desired item(s).
? Help I

The selected items will then be inserted into your Shorthand text. For example, if the
user selects 8.5 x 11, thestring "8.5 x 11" will be inserted in the text Shorthand transfers
to your word processor.

Y ou can use more descriptive text to display to user by using the {@REM text} tag. If
an {@REM text}, tag appearsin an { @INPUT} item line, Shorthand will display text in
the selection list. For example, the following Text to Type:

{@NPUT Enter paper size[aer]
{@REM Letter}8.5 x 11[er]
{ GREM Legal } 8.5 x 14[er]

{ @REM Hal f size}5 x 8. 5[
}

will display a dialog box with the following list of items:

Shorthand Input Field #2

Enter paper size

[— Colummns: H o Back |

O Letter “=“—Restart |

[J Legal '\ Use the {@REM} tag to

[ Half size control how the items BiBw |
are displayed to the o |
user.

i

7 Help

To make a selection, the user simply checks the desired item.



80 Shorthand How-to Guide

The selected item will then be inserted into your Shorthand text. For example, if the
user selected Letter, the string "8.5 x 11" will be inserted in your Shorthand text.

Example problem
How do | use Shorthand to type out the following sentence?

Upon entry, the patient was suffering from: (list of symptoms).
where the list of symptoms can be one or more of:
Dizziness, Headache, Abdominal Pain, Fever

If the patient has more than one symptom, the symptoms are to be separated by slashes
AR

Solution
Create a new Shorthand entry with the following data:

Keyword:
Text to Type:

Upon entry, the patient was suffering from {@NPUT Choose the
synptons that apply @SEP="/" [eer]

Di zzi ness [

Headache [erer|
Abdoni nal Pai n[ee
Fever [ente)

}

Test the entry
1) Make sure Shorthand is running and minimized (click Shorthand's Hide button).

2) Bring up your word processor and create or open a document.

3) Inyour word processor, type: synps1 [sec

4) Shorthand displays a dialog box asking you for the symptoms with alist of choices.
Select one or more items and click on the Next button or press :

5) Shorthand displays the Text to Type dialog box showing a preview of the text that
will be inserted into your word processor. |f you see a mistake, you can make changes
in thiswindow or click the Restart button to start over. Click the Type It button or
press to insert the text to your word processor.
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How it works
Here's an explanation of the code in the Text to Type box:

Upon entry, the patient | Typesthe textasis.

was suffering from

{ @ NPUT Choose the Displays an input dialog with the prompt "Choose the symptoms
synptons that apply that apply".

@BEP="/" Tells Shorthand to place a "/" between selected items.

Di zzi ness These are the items that will be appear in the selection list.
Headache

Abdom nal Pain

Fever

} Closing brace for the {@INPUT} tag.

? The separator string specified by @SEP can be any string including { @KEY} codes.
For example, to place each selected item in anew line, specify:

@BEP="{ @KEY enter}"

@ You can navigate the pick list window entirely through
the keyboard: Use the arrow keys on your keyboard to scroll
up and down the list and press SPACE to select/deselect an
entry. Press ENTER to go to the next screen.

@ Tags can be embedded in pick lists.

Pick lists can contain any valid Shorthand text, including tags.
The only limitation is that each pick list entry has to be a single
line. For example, if you wish to have a pick list call up another
pick list, you can save the second pick list in a text file and then
embed an {@INPUTFILE} tag (see p. 82 for how fo insert files
in Shorthand text) in the first pick list. We work around the
one-line per entry limitation of pick lists by saving the second
pick list in a file and using the {@INPUTFILE} tag to read the
file.
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How to insert a text file

Y ou can insert the contents of atext file into your Shorthand text with the
{@INPUTFILE} tag. The syntax of thetagis:

{@INPUTFILE filename}

where filename is the name of the fileto import. The { @INPUTFILE} tag can read only
plain text files (i.e. files that you can read with NOTEPAD); files such as Word .doc
filesand .JPG files cannot be imported into Shorthand (but see How to insert non-text
filesinto your word processor on p. 84). If thetext file imported by { @ NPUTFILE}
contains Shorthand tags, the tags will be evaluated by Shorthand.

Example problem

| have several Shorthand entries that contain my phone number. How do | set up the
entries so that | don't have to modify each entry if my phone number changes?

Solution

1) Create atext file called phone.txt (using Windows NOTEPAD) containing your
phone number:

(999) 123- 4560

2) Savethe phone.txt in your C:\My Documents folder.

3) Modify your Shorthand entries that contain your phone number to import in the text
file. For example:

Keyword:
Text to Type:

If you have questions, please call me at {@NPUTFILE "c:\ny
docunent s\ phone. txt"}.

4) 1f the phone number changes, we only need to modify the phone.txt file.
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Test the entry
1) Make sure Shorthand is running and minimized (click Shorthand's Hide button).

2) Bring up your favorite word processor.
3) Inyour word processor, type:
al

The result should be:
If you have questions, please call me at (999) 123-4560.

How it works
Here's an explanation of the Shorthand code in the Text to Type box:

I f you have questi ons, Types out "If you have questions, please call me at".
pl ease call ne at

{ @NPUTFI LE Reads in the contents of phone.txt.
"c:\ny docunent s\ phone.txt" | Note thatsince the pathname is enclosed in double
} quotes because the name contains a space. If we left out

the double quotes, Shorthand will attempt to read in the
file called c:\my which is not what we want.

Types out a period.

@ You can use the {@INPUTFILE} tag to get around

the 32,000 character limit in the Text to Type box.
The Text to Type box can support a maximum of 32,000
characters. You can increase this limit to 64,000 characters by
saving your text in a file then using the {@INPUTFILE} tag to
read in the file. Shorthand has an internal limit of 64,000
characters for long forms; for files larger than 64,000
characters, you can use Shorthand s {QKEY} tag to simulate
your word processor s commands to insert the file directly into
your word processor (see p. 84).

83
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How to insert non-text files into your word

processor

Y ou can use Shorthand's { @KEY} tag to simulate the keyboard commands to import a
non-text file into your word processor.

Example problem

My company's logo is saved in afile called "logo.jpg" in the C:\My Documents folder.
How do | create a Shorthand entry to insert the logo into a Microsoft Word document?

Solution
Create a new Shorthand entry with the following data:

Keyword: [Togol |

Text to Type:
| {@EY al t +i } pf { @AUSE} c:\ Wy Docunent s\ | ogo. j pg{ @AUSE} { @EY al t +r} \

Test the entry
1) Make sure Shorthand is running and minimized (click Shorthand's Hide button).

2) Bring up Microsoft Word and create or open a document.
3) Type: |ogol
Microsoft Word will insert logo.jpg into the document.

How it works
Here's an explanation of the Shorthand code in the Text to Type box:

{ @EY alt+i} Simulates Alt+ to bring up Word's Insert menu.

p Chooses Picture from Word's Insert menu..

f Chooses From File from the Picture submenu.

{ @AUSE} Pauses 1 second to allow time for Word to display
the Insert Picture dialog box.

c:\nmy docunent s\l ogo.jpg Types the filename in the File name box.

{ @PAUSE} Pauses a second to give Word time to accept the
filename.

{@XEY alt+r} Simulates Alt+R to choose the Insert button.
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How to prevent extra spaces after an expansion

When you type (or any non-alphanumeric key) after akeyword, Shorthand will
expand the keyword and insert the SPACE (or non-al phanumeric character) you typed.
There are times when you just want to expand a keyword and don't want the SPACE to
be inserted; to prevent the extra space, specify the { @NOSPACE} tag anywhere in your
Text to Type.

The syntax for the { @QNOSPACE} tag is.
{@NOSPACE}
and it can be placed anywhere in your Shorthand text.

Example problem
| have akeyword called subj which will type out a heading called "SUBJECTIVE:"
followed by exactly two new lines. For some reason, I'm getting three new lines when |
typesubj [=ve]. Hereis my definition:
Keyword:

Text to Type:

‘ SUBJECTI VE: { @XEY Enter}{ @EY Enter}

Solution

The extraline is coming from the key you typed after the keyword. To prevent the
extraline, add { @QNOSPACE} in your Shorthand text:

Keyword:
Text to Type:

[ SUBJECTI VE: { @EY Enter}{ @EY Ent er}{ GNOSPACE}

@ The TAB key expands keywords without
inserting a space.

An alternative way to prevent extra spaces is to press

the TAB key after typing the keyword. Pressing TAB

after a keyword will immediately expand the keyword

without inserting extra spaces.
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How to remove unwanted lines

The { @DELETELINE} tag removes the entire line it is on (we define a"line" here to
mean a series to characters that ends with a in the Text to Type box).

The syntax for the { @DELETELINE} tagis:
{@DELETELINE}

Example problem

| have a series of { @QINPUT} pick list tags to get input from the user but some of the
inputs should not be typed out if the question is not applicable. How can | get rid of
unneeded @INPUT tags?

Solution

The solution isto add an item to your pick list to delete the @INPUT tag. For example,
let's expand the example on p. 80 to add a "not applicable" option:

Text to Type:

Upon entry, the patient was suffering from {@NPUT Choose the
synptons that apply @SEP="/" [eer]

Di zzi ness [

Headache [enrer|
Abdomi nal Pai n ]
Fever [

{ @EM Not Appl i cabl e} { @ELETELI NE}
}

Now when the user selects "Not Applicable”, Shorthand will process the
{ @DELETELINE} tag and the line "Upon entry, the patient was suffering from..." will
not be typed out to your word processor.
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How to use variables

Theresults of { @QINPUT} tags can be stored into avariable. By placing the variablein
your Text to Type, you can insert the result of an { @INPUT} tag without having to ask
the same question again.

To tell Shorthand to save the result of an { @QINPUT} tag to avariable, you enter a
variable name enclosed by parentheses directly after the tag name. For example:
{@INPUT (var) prompt}
{@INPUTDATE(var) prompt}
{@INPUTFILE(var) prompt}

where var is the name of the variable. The variable name can be any alphanumeric
string without any spaces.

When Shorthand processes an { @QINPUT} tag with avariable, Shorthand will replace all
instances of the string {var} with the result of the { @INPUT} tag (where var, again,
refers to the name of the variable).

Example problem

How do | create a Shorthand entry for the following paragraph with STATE replaced by
the state specified by the user?
Choice of Law. This agreement will be governed by the laws of STATE and you agree that

any claims regarding the Product shall be brought in STATE, and waive any objections to
jurisdiction in the U.S. District Court for the District of STATE or the STATE Superior Court.

Solution
Here's how the Shorthand code should ook like:

Text to Type:

Choi ce of Law. This agreenent will be governed by the | aws of

{ @ NPUT( STATE) Enter state} and you agree that any clainms regarding

t he Product shall be brought in {STATE}, and waive any objections to
jurisdiction in the U S. District Court for the District of {STATE}

or the {STATE} Superior Court.

How it works

We use an { @INPUT} tag to get the name of the state from the user and store the result
to avariable named STATE. Shorthand will then replace al instances of { STATE} with
the string entered by the user in the Input dialog box.
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How to output braces
The { @LEFTBRACE} tag outputs a left brace: {.
The { @RIGHTBRACE} tag outputs aright brace: }.

The { @LEFTBRACE} and { @QRIGHTBRACE} tags are useful if you want Shorthand
to type out strings that can be interpreted as tags.

Example problem

How do | create a Shorthand entry for the following paragraph with the string
"{@INPUT}" actually typed into my word processor?

The Shorthand tag to display an input window is: {@INPUT}.

Solution
Here's how the Shorthand code should ook like:

Text to Type:

The Shorthand tag to display an input wi ndows is:
{ @Q EFTBRACE} @ NPUT{ @Rl GHTBRACE}

How it works

We use the { @LEFTBRACE} and { @QRIGHTBRACE} tagsto display the{ and }
characters.

Here's an explanation of the code in the Text to Type box:

The Shorthand tag Shorthand types the text as is.
to display an
i nput wi ndows is:

{ Q.EFTBRACE} Shorthand types a {

@ NPUT Shorthand types the text as is.

{ @Rl GHTBRACE} Shorthand types a }
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Chapter 5 Tcl Scripts

Overview

The { @INPUTTCL} tag is a powerful programming feature that allows you to embed

programming code in your Shorthand text.

Tcl (pronounced “tickle”) stands for Tool Command Language and is a popular scripting
language for “gluing” applications and text data. Tcl was developed by John Ousterhout
at the University of California; the Tcl libraries, source code, as well as many tools and
extensions are available free from the Internet.

A Quick Introduction to using Tcl

Tcl code looks very much like the commands you enter in the Windows console (or

DOS window).

For example, the Tcl code

cd /tnmp/dirl

will change the current working directory to /tmp/dir1l.

The Tcl code

file rename john.txt fred.txt

will rename afile called “john.txt” to “fred.txt”.

To give you an idea of the power of Tcl, below is a brief sampling of the standard
commands availablein Tcl.

String Commands

f or mat

regexp

regsub

scan

string conpare
string length
string range

List Commands

| append
li ndex
i nsert
[l ength
| repl ace
| search
| sort

Creates formatted output.

Matches strings using powerful regular expressions (e.g. *.%).
Performs a search and replace.

Parses and extracts values from a string.
Compares 2 strings.

Returns the length of a string.

Extracts a substring from a string.

Appends an element to the end of a list.
Returns a list element.

Inserts an element into a list.

Returns the number of elements in a list.
Replaces a range of list elements.
Searches a list.

Sorts a list.

Copyright © 2002-2005 by OfficeSoft LLC (http://pcshorthand.com). It is illegal to copy any portion of this book.
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Control Flow Commands

i f

f or each
whil e

br eak
conti nue

File Commands

cd

pwd

gl ob

open

cl ose

seek

read

puts

source

file copy

file delete
file renanme
file exists
file size

file atime
file dirnanme
file extension
file rootnane
file isdirectory

System Commands

exec
cl ock seconds
cl ock fornmat
dde

Errorsand Exceptions

cat ch
error

Math Commands

i ncr
expr

Conditionally evaluates a script.

Loops through a script.

Loops through a script.

Exits a loop.

Continues execution at the start of a loop.

Changes the current working directory.
Returns the current directory.

Returns a list of files with pattern matching.
Opens a file for reading/writing.

Closes an open file.

Sets the file s access position.

Reads from a file.

Writes to a file.

Reads and evaluates a script stored in a file.
Copies a file.

Deletes a file.

Renames a file.

Determines if a file exists.

Returns the file size.

Returns the file time.

Returns the file s directory.

Returns the file s extension.

Returns the file s root name.

Determines if a string is the name of a file or a directory.

Executes an external Windows application.

Returns current time in seconds.

Returns a formatted date/time string.

Communicates with other applications through the Windows
Dynamic Data Exchange.

Executes a specified script if an error occurs.
Generates an exception and aborts the script.

Increments (adds 1 to) the value of a variable.

Evaluates a mathematical expression, e.g. expr 10.1 * 0.08.
In addition to the basic arithmetic operations (+, -, *. /), Tcl
also provides advanced math functions for computing square
roots, logarithms, sine/cosine, exponentials, etc.
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An important feature of Tcl isthat you are not limited to the commands listed in the
preceding pages. Tcl is extensible which means new commands can be added to increase
the functionality of Shorthand:

Shorthand Extension Commands

run Launches a Windows file or program (see p. 98).

sh_file Manages Shorthand dictionaries (e.g. open, close or save a dictionary) (see
p. 124).

sh_i nput Displays an input dialog box (see p. 112).

sh_list Manages your word lists (e.g. add an entry, search for a keyword, modify
the text to type) (see p. 100).

sh_set Sets the Shorthand parameters (e.g. turn AutoReplace on/off) (see p. 104).

Refer to Shorthand's on-line help for the technical details on the Shorthand Extension
commands; examples on how to use some of the extension commands are presented
in the following pages.

Tcl Resources

Teaching Tcl programming is beyond the scope of thisbook. To get started with Tdl, it
is recommended you visit the many Tcl web sites on the Internet (e.g.

http://ww. scriptics.com). A very good Tcl book is Practical Programming in Tcl
and Tk (3rd Edition) by Brent B. Welch (Addison-Wesley, 2000; ISBN: 0130220280).

Shorthand installs only the “core” Tcl scripting language and does not load the Tk
libraries (Tk is awindowing/graphics library extension for Tcl); when reading a book on
Tcl, you can concentrate only on the first few chapters that explain the basic Tcl
commands and skip the sections on Tk.

@ You can run Tcl scripts interactively from
Shorthand.

To familiarize yourself with Tcl commands, you can choose

File=>Tcl Script from Shorthand's Main Menu to bring up a

dialog box in which you can interactively experiment with Tcl

commands.
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Guidelines for writing Tcl scripts in Shorthand

Keep Tcl scripts short and simple.

Short scripts are easier to debug and understand. If you need to do something complex,
consider writing it as a separate application using a high level language such as Visua
Basic which can be launched from Shorthand with the Tcl r un command.

Use the sh_input Tcl command to get data from the user.

You can usethe sh_i nput command to display dialog boxesto the user. See
Shorthand's on-line help for the syntax of these commands. The following example asks
the user for a name and returns the name in uppercase:

{ @NPUTTCL [[even)
set nane [sh_input string "Enter your name"]; [

if {$name=="SH CANCEL"} { return ""; } [

return "Your Nane: $name\nYour Nane in UPPERCASE: [string toupper
$nane]"; [eved]

}

An dternative is to use the @INPUT tag to place the user input into a Shorthand variable
and embed the variable in the @INPUTTCL script. This example does the same thing as
the previous example except that an @INPUT tag is used to get the name whichis
passed to a Tcl script through the “{ name}” variable:

Your Name: {@NPUT(nane) Enter your nane:} [ene
Your Name in UPPERCASE: { @ NPUTTCL [ener]

string toupper "{name}" [eA]
}

@ Note that the double quotes (" ") around { nane} are necessary since { nane} can contain
gpacesand the st ri ng toupper Tcl command expects only a single argument.
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Use the @REM Tag to prevent the result of an @INPUT tag from being
displayed.
If you enclose an @INPUT tag inside an @REM tag, the result of the @INPUT tag will
not be inserted into your word processor. The following code is the same as the previous
example except that only your name in uppercase is sent to your word processor:

(@M [
{@NPUT(name) Enter your nane:} [ened]
}Your Name in UPPERCASE: {@ NPUTTCL [eneA]

string toupper "{name}" [eA]
}

Use ‘run’ instead of ‘exec’ to launch applications.

Using the standard Tcl exec command to launch an external program will lock up
Shorthand since Shorthand cannot continue until the program that was launched is
completed. The exec command aso does not work with command-line calls (such as
command.com and the di r command).

Instead of using exec, launch external programs with the r un command. Ther un
command is a Tcl extension command implemented by Shorthand and takes the same
arguments as the Run command found by clicking on the Windows START button.

Here is an example that opens afile called MyFile.doc in Microsoft Word:

{ @NPUTTCL [enren
run "C:/Program Fil es/ MSOF fi ce/ Word. exe" "MFil e. doc" [
}

? In Tcl scripts, you will need to convert all backslashes ‘\’ to forward slashes ‘/* when
specifying Windows path names.

The r un command recognizes Windows registered file types. For example, the
following code will open aweb site in your default Internet browser

{@NPUTTCL [vier]
run "http:://ww. pcshorthand. cont' [ene
}
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Delete unneeded variables.

Any Tcl variable declared in a Tcl script will stay in memory until you explicitly clear it.
It is possible to run out of Windows memory and lock up your computer if the space
occupied by variables grows too large. Usethe Tcl unset command to delete a variable.

In the following example, the first @INPUTTCL tag reads afile of names and displays
the names in sorted order. The second @INPUTTCL tag callsthe Tcl unset command
to destroy the variables created in the first @INPUTTCL tag:

{ @ NPUTTCL
# open a file containing a list of nanes
set f [open "C: /M Docunents/namnelist.txt"]
# read the file's contents to a ‘nanmes’ array
# (assunes the file contains 1 nane per |ine)
while {[gets $f line] >=0 } {
| append naneList $line
)
# close the file
cl ose $f
# sort the |ist
set naneList [Isort $nameList]
# display the sorted list; one nane per |ine
return [join $naneList "\n"]
} {@NPUTTCL
# clean up: destroy the variabl es used above
unset naneLi st
unset f
unset |ine
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Create global commands/variables in the SHORTHND.TCL file.

When Shorthand first starts up, Shorthand executes the contents in SHORTHND.TCL as
aTcl script. You can therefore introduce global commands or variables by placing them
in the SHORTHND.TCL file.

For example, you can create a global variable for your name in SHORTHAND.TCL by
adding the line:

set myNane "Jane Smith"
And you can use the variable in your Shorthand text:

Sincerely, [eed
{@NPUTTCL return $nyNane }

So if you give your Shorthand dictionary to someone else, that person can reuse your
dictionaries by simply entering her name into the SHORTHND.TCL file instead of
having to modify all the Shorthand entries that contains your name.

See also p. 101 for an example of how to define a new Tcl command that can be called
from all your Tcl scripts.

Do not use Tcl commands that read/write to the console.

Shorthand does not create a Tcl console window so Tcl commands that read/write to the
console (such as puts "hel | 0") will NOT work and will generate an error.

@ Use Tcl s backslash substitution to handle special
characters in strings.

The characters [ 1{ } “ have special meaning in Tcl. If

you need to include those characters as part of a string, you

can do so by preceding the character with a backslash. For

example, the Tcl command

puts "\"hello\""

will print out hello (with double quotes) . Refer to a Tcl book
for additional backslash substitution characters.
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How to run Tcl scripts in Shorthand
Tcl scripts are embedded in your Shorthand code through the { @INPUTTCL} tag.
The syntax of the @INPUTTCL Tagis:
{@INPUTTCL script}

where script isa Tcl script and can contain any number of lines.

How are {@INPUTTCL} tags processed?

Shorthand evaluates the Tcl script through the Tcl interpreter and replaces the
{@INPUTTCL} tag with the result of the script. The result of the script is either the
argument of the Tcl r et ur n command or the result of the last linein the script.  There
are three special return values: "SH_BACK", "SH_CANCEL" and "SH_RESTART". If
your Tcl script returns the string "SH_BACK", Shorthand will go back and display the
previous @INPUT* tag. If the return valueis"SH_CANCEL", Shorthand will abort the

input session. A return value of "SH_RESTART" tells Shorthand to restart from the
beginning.

When are {@INPUTTCL} tags processed?

Shorthand processes all { @INPUTTCL} tags before inserting any text into your word

processor. This means that, once expansion has started, all Tcl scripts have already been
evaluated.

Example problem

How do | writea Tcl script to type out today's date in the following format:
"month/day/year"?

Solution
Create a dictionary entry with the following Shorthand code:
Text to Type:
{ @ NPUTTCL
set t [clock seconds]

clock format $t -format "%m %/ %" [eer
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How it works
Here's an explanation of the code in the Text to Type box:

{ @ NPUTTCL Starts the INPUTTCL tag..
set t [clock seconds] Gets the current time (in seconds) and stores it in the Tcl variable
called "t".

clock format $t -format | Reads the time stored in variable t. and converts it to a string in the
"o Yel/ Wy format "month/day/year". Since this is the last line of the script, the
result of this line will be returned to Shorthand.

} Closing brace for the @INPUTTCL tag. Be careful not to type an
extra space after the '}".

How to run a Tcl script with a single keystroke

You can run a Tcl script with asingle keystroke by creating a File Shortcut. Follow the
procedure on p. 42 to create afile shortcut and specify the filename of the Tcl script in
step 3. Note that the Tcl file must end with the extension ".tcl" so Shorthand knows the
file containsa Tcl script.

A note on Tcl variables

Shorthand evaluates scripts in the same Tcl interpreter so any variables you define are
global and can be used in other @INPUTTCL tags. In the following example, the
second @INPUTTCL tag is able to read the current time from the t variable which was
initialized in the first @I NPUTTCL tag:

Text to Type:

Today's Date is {@NPUTTCL

set t [clock seconds]

clock format $t -format "% %/ %"
}.

Today is {@NPUTTCL

clock format $t —format "9A"

}.

will result in something like:
Today s Date is 08/15/00.
Today is Tuesday.
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How to launch applications with Tcl

Therun Tcl command can be used to launch applications such as your word processor
or web browser. The syntax of therun Tcl command is:

run filename

Example problem

How do | use Shorthand to open my web browser to the http://www.pcshorthand.com
web site?

Solution
Create a new Shorthand entry with the following data:

Keyword:
Text to Type:

{@NPUTTCL [avier]
run "http:://ww. pcshorthand. cont' [ene
}

@ Remember that pathnames in Tcl are separated by
forward slashes.

Unlike Windows, Tcl uses forward slashes to separate

pathnames. For example: "C:/My Folder/My File".

The reason for this is because backslashes have special

meaning in Tcl.  Also remember to enclose pathnames that

contain spaces with double quotes so Tcl knows that the

spaces are part of the pathname.

@ Use the Windows Run command to test commands
for the Tcl run command.
For most cases, anything you can do with the Windows Run
command should work with the Tcl run command as well. The
Windows Run command is accessed by clicking on the
Windows Start button then choosing Run. Remember to
convert all backslashes in filenames to forward slashes when
using the Tcl run command.
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How to simulate keystrokes with Tcl

You can usethesh_screen key command to simulate a keystroke from within a Tcl
script. The syntax is:
sh_screen key args

where args is one or more keystroke codes (e.g. Shift+F12 or Ctrl+Alt+Space)
separated by spaces; thesh_screen key command isthe Tcl equivalent of the
{@KEY} tag (p. 68).

Example
See p. 108 for an example of how the usethe sh_screen key command.

(&~ Notes
Unlike the { @KEY} tag, sh_screen key is executed when Shorthand reads the Tcl
script and not when the long form is expanded. Y ou normally need ash_wi ndow
pause command (p. 108) before or after the command to make sure the key is
interpreted correctly by your word processor.

To simulate more than one keystroke, separate the keystroke codes with spaces. For
example, the command to ssmulate theword " Hel | 0" is:

sh_screen key "H' "e" "I" "|" "o"

@ Use the clipboard to "read" text from your word processor.
You can transfer text from your word processor to Shorthand through the clipboard. For
example, the following code capitalizes the last word in your word processor:

{ @ NPUTTCL

# make sure Al't key is rel eased

while {[sh_screen iskeydown alt} { };

sh_screen key ctrl+shift+left; # select |last word
sh_screen key ctrl+c; # copy to clipboard

sh_wi ndow pause 100; # give tinme for clipboard copy
set s [sh_set clipboard]; # get text fromclipboard
return [string totitle $s]; # capitalize and return

}

Note: To make the above code work, create a dictionary entry (p. 24), copy the above code
(exactly 9 lines) to the Text to Type box and assign a shortcut key (e.g. Ctr+F9 ). To use
the code, simply press the shortcut key (e.g. Ctrl+F9) after a word in your word processor.
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How to import text from another dictionary entry

The sh_li st command can be used to find and read the text from another entry in the
active dictionary.

Example problem
| already have two dictionary entries containing my first name and last name:
fnane = John

| nane = Snmith

How do | create anew entry that will import f name and | nane and form my full name?

Solution
Create a new Shorthand entry with the following data:

Keyword: [ fullname |

Text to Type:

{@ NPUTTCL
proc sh_expand {keyword} {
set i [sh_list search $keyword];
if {$i >= 0} {
return [sh_list text $i];
} else {

return ""; # not found [ee
} [EveR]
} [EveR]

return "[sh_expand fnane] [sh_expand | nane]" [eed]
}
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How it works

proc sh_expand {keywor d}

Defines a new Tcl command called sh_expand which
finds and return the text associated with $keyword.

set i [sh_list search Searches for $keyword in the active dictionary and sets i to
$keywor d] ; the index number (an integer) of the entry.
if {$i >= 0} { Tests if the $keyword was found: If the index number is

greater than or equal to zero, the $keyword exists in the
dictionary.

return [sh_list text $i];

Returns the text (long form) associated with the entry at
index $i.

} else {

return ""

}

If $i is negative, the $keyword was not found, so we just
return a blank string.

return "[sh_expand fnane]
[ sh_expand | nane]"

Invokes the sh_expand command to fetch the text of
fname and Iname and returns the combined string to be
typed out by Shorthand.

How to make sh_expand available to all Tcl scripts

If you define the sh_expand proc in the SHORTHND.TCL file (see p. 95), the
sh_expand command will be availableto all your Tcl scripts. That is, if your
SHORTHND.TCL file contains:
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proc sh_expand {keyword} { [eved]
set i [sh_list search $keyword];

if {$i >= 0} {

return [sh_list text $i];

} else {

e

e

return "" # not found [eer
} [y
} ENTERI

The Text to Type of the above example can be simply:

{ @NPUTTCL [[even]
return "[sh_expand fname] [sh_expand | name]" [
}
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How to perform arithmetic computations
The expr Tcl command can be used to evaluate math expressions. The syntax is:
expr expression

where expression is a mathematical expressionsuchas(1 + 6)*1.08; refertoaTcl
book or the Tcl web site (p. 91) for detailed documentation on the expr command.

Example problem

How do | display a dialog box asking for the user's birth date then compute the user's age
from the user's input?

Solution
Create a Shorthand entry with the following data:

Keyword:
Text to Type:

{ @ NPUTTCL
# Get birthdate [even

set s [sh_input date "Enter your birth date:" ""]; [ee
if {$s == "SH CANCEL"} {return ""} [&

# conpute age

set date_seconds [clock scan $s];

set now _seconds [cl ock seconds];

set age_seconds [expr $now seconds - $date_seconds];
set seconds_per_year [expr 365 * 24 * 60 * 60];

set age_years [expr $age_seconds/ $seconds_per_year];
# return age

return "Your age is: $age years"; [ene
}
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Test the entry
1) Make sure Shorthand is running and minimized (click Shorthand's Hide button).

2) Bring up your word processor and create or open a document.

3) Inyour word processor, type: agel

4) Shorthand displays a date dialog box asking for a birth date. Enter your date of birth
and click OK.

5) Shorthand inserts your age in your word processor.

How it works

set s [sh_input date Displays date dialog box and returns the result in
"Enter your birth date:" variable s.

1

if {$s == "SH CANCEL"} Checks if the user had clicked the CANCEL button.
{return ""}

set date_seconds [clock Converts the date string in s to time in seconds.
scan $s];

set now_seconds [cl ock Gets the current time in seconds.

seconds] ;

set age_seconds [expr Computes age (in seconds) by subtracting user's
$now_seconds - birth date from today's date.

$dat e_seconds] ;

set seconds_per _year Converts age in seconds to age in years.
[expr 365 * 24 * 60 *

60] ;

return "Your age is: Returns the result.

$age_years";

@ Tcl supports advanced mathematical expressions.
The Tcl expr command supports advanced mathematical
functions such as sines and cosines, logarithms, square roots
and random numbers. Consult a Tcl book for more details on
the expr command.
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How to enable/disable AutoReplace with a single
keystroke

Y ou can turn on/off AutoReplace with the sh_set aut or epl ace Tcl command.
The syntax is:

sh_set autoreplace value
where value is either 1 to enable AutoReplace or 0 to turn off AutoReplace.

Example problem
How do | turn on/off AutoReplace with single keystroke?

Solution

We will use the toggle_autor eplace.tcl script that comes with Shorthand; you should
find thisfile in your Shorthand folder. If you can't locate it, you can use NOTEPAD to
create afile called toggle autoreplace.tcl that contains the following 5 lines:

if {[sh_set autoreplace ]} { [eved
sh_set autoreplace 0; [even
} else { [ove

sh_set autorepl ace 1;
}
Follow these steps to create a shortcut key to launch the toggle autoreplace.tcl script:

1) Choose Shortcuts=>Edit . The 3. File Shortcutstab in Shorthand Preferences
window appears.

2) Click the Add button. The Specify a File Shortcut window appears.
3) Click the Browse button and open the toggle_autor eplace.tcl file.

4) In the Specify aFile Shortcut window, click the Shortcut button and press
Shift+Ctrl+A (or you can specify another keyboard shortcut if you want).

5) Inthe Specify aFile Shortcut window, enter "Toggle autoreplace” in the
Description box.

6) Inthe Specify a File Shortcut window, click OK to save your entry. The Preferences
window reappears, click OK again to close the window and return to Shorthand's Main
window.



Chapter 5 Tcl Scripts 105

Test the entry
1) Make sure Shorthand is running and minimized (click Shorthand's Hide button).

2) Start your word processor.

3) Inyour word processor, press Shift+Ctrl+A to switch Shorthand's AutoReplace on
and off. When AutoReplace is off, Shorthand will not expand abbreviations as you type.
If you enabled Shorthand's Suggestion Window, you should notice the Suggestion
Window appear when AutoReplace is on and disappear when AutoReplace is turned off.

How it works

The Shortcuts= Edit command allows you to assign a keyboard shortcut to runaTcl
script stored in afile. Here's an explanation of the contents of the toggle_autoreplace.tcl

file:
if {[sh_set autoreplace 1} { Tests if AutoReplace is currently on.
sh_set autoreplace 0, If AutoReplace is currently on, turn it off
} else { else turn it on.
sh_set autorepl ace 1;
}

@ How does Shorthand know if a file
contains a Tcl script?

Shorthand looks at the filename's extension to

determine the contents of a file. Files that

contain Tcl scripts end with the extension ".tcl".

Files that contain Shorthand dictionaries have

an extension of ".spf".
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How to show/hide the Suggestion Window with a
single keystroke

Y ou can show or hide the Suggestion Window with the sh_set suggesti on_w ndow
command.

The syntax is:
sh_set suggestion_window value
where value is either 1 to enable AutoReplace or 0 to turn off AutoReplace.

Example problem
How do | show or hide the Suggestion Window with a single keystroke?

Solution

We will use the toggle_suggestion_window.tcl script that comes with Shorthand; you
should find this file in your Shorthand folder. If you can't locate it, you can use
NOTEPAD to create afile called toggle_suggestion_window.tcl that contains the
following 5 lines:

if {[sh_set suggestion_wi ndow ]} { [&r]
sh_set suggestion_wi ndow 0; [er]

} else { [
sh_set suggestion_wi ndow 1; [
}

Follow these steps to create a shortcut key to launch the toggle suggestion window.tcl
script:

1) Choose Shortcuts=>Edit. The 3. File Shortcuts tab in Shorthand Preferences
window appears.

2) Click the Add button. The Specify a File Shortcut window appears.
3) Click the Browse button and open the toggle_suggestion_window.tcl file.

4) In the Specify aFile Shortcut window, click the Shortcut button and press
Ctrl+Shift+S (or you can specify another keyboard shortcut if you want).

5) Inthe Specify aFile Shortcut window, enter "Toggle suggestion window" in the
Description box.

6) In the Specify a File Shortcut window, click OK to save your entry. The Preferences
window reappears, click OK again to close the window and return to Shorthand's Main
window.
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Test the entry
1) Make sure Shorthand is running and minimized (click Shorthand's Hide button).

2) Start your word processor.

3) Inyour word processor, press Ctrl+Shift+S to switch Shorthand's Suggestion
Window on and off. Note that AutoReplace must be enabled for the Suggestion
Window to work.

How it works

The Shortcuts= Edit command allows you to assign a keyboard shortcut to runa Tcl
script stored in afile. Here's an explanation of the contents of the
toggle suggestion_window.tcl file:

if {[sh_set suggestion_wi ndow ]} { Tests if AutoReplace is currently
on.
sh_set suggestion_w ndow O; If AutoReplace is currently on,
turn it off
} else { else turnit on.
sh_set suggesti on_w ndow 1;
}

@ Use the Suggestion Window to debug Shorthand.
The first line of the Suggestion Window always displays the
contents of Shorthand's internal keyboard buffer. If you
experience problems with Shorthand, you can examine what
Shorthand thinks you are typing and compare it with what you
are actually typing. This helps you determine if Shorthand is
working properly.
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How to add delays within a Tcl script

You can usethe sh_w ndow pause command to temporarily pause a Tcl script. The
syntax is:

sh_window pause value
where value is the minimum delay time in milliseconds.

@ Unlike the { @QPAUSE} tag (p. 72), the sh_w ndow pause command is evaluated
immediately when Shorthand reads the Tcl script and not when Shorthand writes the
Text to Type to your word processor. So placing a sh_wi ndow pause command
between { @KEY} tags will have no effect; the sh_wi ndow pause command should be
used only to insert delaysinside a Tcl script.

Y ou normally need to use the sh_wi ndow pause command after a sh_screen key
(p- 99) or run (p. 98) command to allow the computer to process the command.

Example problem

What is the Tcl equivalent of the example on p. 72 to create a keyboard shortcut to move
the cursor to the next occurrence of the word "INPUT:" in a Microsoft Word document?

Solution
Create a new Shorthand entry (p. 24) with the following data:

Keyword: [ find inputl ] Shortcut: [ Crl+Alt+l |

Text to Type:

{ @ NPUTTCL

whil e {[sh_screen iskeydown alt]} { }

while {[sh_screen iskeydown ctrl]} { }
sh_screen key "alt+e"; sh_w ndow pause 100

sh_screen key "f"; sh_w ndow pause 500
sh_screen key "1"; sh_w ndow pause 100
sh_screen key "N'; sh_w ndow pause 100
sh_screen key "P"; sh_w ndow pause 100
sh_screen key "U'; sh_w ndow pause 100
sh_screen key "T"; sh_w ndow pause 100
sh_screen key ":"; sh_w ndow pause 100

sh_screen key "alt+f"; sh_wi ndow pause 100 [

return "" [
}




Chapter 5 Tcl Scripts 109

Test the entry
1) Make sure Shorthand is running and minimized (click Shorthand's Hide button).

2) Bring up Microsoft Word and create or open a document that contains several
instances of the word "INPUT:".

3) In Microsoft Word, press Ctrl+Alt+l.

Y ou should see Word bring up the Find dialog box, search for the next instance of
"INPUT:" then close the Find dialog box.

How it works
Unlike the { @KEY} tag, which is executed after Shorthand has returned control to the
word processor, the sh_screen key command is executed immediately. Thefirst two
linesusethesh_screen i skeydown command to wait until the user releases the Ctrl
and Alt keys; without this pause, the Ctrl and Alt keys may still down when sh_screen
key "alt+e" isexecuted which will beinterpreted by your word processor as
Ctrl+Alt+E instead of Alt+E.

The sh_wi ndow pause 100 commands are used to insert short 100 millisecond pauses
after every keystroke to give Microsoft Word time to process each keystroke.

The script endswitha return "" which returns a blank string to your word processor.

@ Disable NUMLOCK when simulating keys on the
Numeric Keypad.

When simulating numeric keypad keys, such as the Arrow

keys, Home key and PgDn key, you should disable your

keyboard's NUMLOCK key to avoid possible misinterpretation

of the {@KEY} codes by your word processor.
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How to convert text to Title Case

You canuse Tcl's string command to process text strings. The syntax of the st ri ng
command is:

string option args
where option is one of many operations supported by Tcl; example options are:
tolower, totitle and toupper to change the case of args.
trim, trimright and trimleft to remove spaces from args.
length to determine the number of charactersin args.
index to return the character at a specified position.

Refer to a Tcl book or the Tcl web site (p. 91) for detailed documentation on the string
command.

Example problem
How do | convert a sentence to title case (i.e. capitalize the first character of each word)?

Solution
Create a new Shorthand entry (p. 24) with the following data:

Keyword: [ totitle |

Text to Type:

{ @NPUTTCL

set s [sh_input string "Enter sentence"]

if {$s == "SH CANCEL"} { return "";}

set s [string totitle $s];

regsub -all {\s\w} $s {[string toupper {\0}]} s2

return [subst $s2];
} { @NOSPACE}
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Test the entry

1) Make sure Shorthand is running and minimized (click Shorthand's Hide button).

2) Bring up your word processor and type: totitle

Shorthand displays a dialog box asking you to enter a sentence.
3) Inthedialog box, type: medical report
Shorthand inserts Medical Report into your word processor.

How it works

set s [sh_input string "Enter
sent ence”]

Displays an input dialog box for
the user to enter a sentence.

if {$s == "SH CANCEL"} { return ""

'}

If the user clicked the Cancel
button, a blank string is returned
to your word processor.

set s [string totitle $s];

Use Tcl's string totitle command
to capitalize the first letter in the
sentence; the remaining
characters will be in lower case.

regsub -all {\s\w} $s {[string
toupper {\0}]} s2

Use Tcl's regsub command to
capitalize each character that
comes after a space.

return [subst $s2];

Returns the processed string to
your word processor. The subst
command is necessary to
evaluate the string toupper
command in the previous line.

H @CSPACE}

The {@NOSPACE]} tag (p. 85)
prevents extra spaces from
appearing in the final output.

111
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How to get user input with Tcl
You can usethe sh_i nput command to ask for user input; the syntax is:
sh_input option prompt arg ?arg...?

where option specifies the type of dialog box and prompt is a string you wish to be
displayed at the top of the dialog box. The return value is the user input if the user clicks
the OK button. The return value isthe string “SH_CANCEL" if the user clicks on the
CANCEL button.

The legal options are:

sh_i nput string prompt ?defaultValue?  Displays an input dialog window with a single
line text box. The text box is initialized with
defaultValue and the user may type anything
in the text box.

sh_i nput neno prompt ?defaultValue? Same as sh_i nput st ri ng except that
a multi line text box is shown in the dialog
window.

sh_i nput date prompt ?defaultvValue? Same as sh_i nput st ri ng except that
a date input box is shown in the dialog
window.

sh_i nput open prompt ?defaultvValue? Same as sh_i nput st ri ng except that
an Open File dialog window is shown.

sh_i nput save prompt ?defaultvValue? Same as sh_i nput st ri ng except that
a Save As dialog window is shown.

sh_input |ist prompt {listitems} Displays a dialog window with a multi-selection

?{defaultSelections}? pick list. listltems is a list of strings to display
in the pick list. defaultSelections are the index
numbers of items in listlfems that you want
selected when the dialog window is first
displayed. The return value is a list of index
numbers of selected items if the user clicked
the OK button. The return value is
SH_CANCEL if the cancel button was

clicked.
sh_input listl prompt {listltems} Sameassh_i nput |ist exceptthat
?{defaultSelections}? only item may be selected.
sh_i nput nsg prompt message Displays a message to the user.
sh_i nput spel | check prompt text Displays a multi-line dialog window and then

spell checks text. Same as executing
sh_i nput neno and clicking on the Spell
Check button.
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Example problem
How do | use Shorthand to type out the following sentence?
Upon entry, the patient was suffering from: (list of symptoms).
where the list of symptoms can be one or more of:
Dizziness, Dry Mouth, Headache, Abdominal Pain, Fever

If the patient has more than one symptom, the symptoms are to be separated by slashes
AR

Solution
Create a Shorthand entry with the following data:

Keyword:
Text to Type:

{@NPUTTCL

set items {"Dizziness" "Dry Muth" "Headache" "Abdom nal Pain"

"Fever"};
set s [sh_input list "Choose synptons that apply" $itens];
if {$s == "SH CANCEL"} {return ""}
set synptoms "";
foreach i $s {
| append synptoms [|index $itenms $i];
)
if {[Ilength $synptons] > 1} {
set synptoms [join $synptons "/"];
} else {
set synptoms [join $synptons];
)

return "Upon entry, the patient was suffering from $synptons";

}
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Test the entry
1) Make sure Shorthand is running and minimized (click Shorthand's Hide button).

2) Bring up your word processor and create or open a document.

3) Inyour word processor, type: synps1 [sec

4) Shorthand displays a dialog box asking for the symptoms with alist of choices.
Select one or more items and click OK.

5) Shorthand inserts the selected items in your word processor.

How it works
set itenms {"D zzi ness"

Creates a Tcl list variable initialized with the 5

"Dry Mouth" "Headache"
"Abdom nal Pain"
"Fever"}

symptoms.

set s [sh_input |ist
"Choose synptons that
apply" $itens];

Calls sh_input to display a pick list dialog box and
returns the result to variable s. The result is a list of
indices into items.

if {$s == "SH CANCEL"}
{return ""}

If the user click CANCEL, return an empty string (i.e.
Shorthand inserts nothing in your word processor)..

set synptons ""

Creates a Tcl variable called symptoms. We will use
this variable to hold the symptoms selected by the
user.

foreach i $s {

| append synptons [I|index
$items $i]

}

This loops through each element in the s list variable
and converts each numerical index in s to a list of
symptom strings.

if {[Ilength $synptons]
> 1} {

set synptons [join
$synptons "/"];

If symptoms has more than one element, join the list
of symptoms into a single string with each element
separated by slashes "/."

}

el se { If symptoms has only one element then just convert
set synptons [join the list of symptoms into a string.

$synpt ons] ;

}

return "Upon entry, the
pati ent was suffering
from $synptons"”;

Returns the result.
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How to export a dictionary to a comma-delimited
text file

If Shorthand's built-in Print to File command (p. 21) does not export your word list in
the right format you can write own Tcl script to dump the contents of the dictionary in
whatever format you need.

Example problem

How do | export my word list to a comma-delimited text file with the strings enclosed in
double quotes? If the string contains a double quote, the double quote should be
preceded by a backslash (\). The output should look something like:

"keyword", "this is the long form" [enTer]
"t1", "\"this long form is enclosed in double quotes\"" [exter]
"t2", "this long form has [[ener]

two lines"

Solution

Create afile caled sh_print_dictionary.tcl with the following Tcl code (the file can
also be downloaded from http://www.pcshorthand.com/book):

proc _print_dictionary { } {
# get conpl ete pathnane of current dictionary.
set dictionaryPathName [sh_file];

# extract rootnane of dictionary
set dictionaryNanme [file rootname $dictionaryPat hNane];

# ask for a filenane with the default name being "dictionaryNanme. TXT"

set filenanme [sh_input save "Enter filename to save the word list"
"${di ctionaryName}.txt"];

if {$filenane == "SH CANCEL"} {return;}

# open file for witing

set f [open $filename W ;

set n [sh_list length]; # get nunmber of entries in active dictionary
set count O;

for {set i 0} {$i < $n} {incr i} {
if {[sh_list readonly $i]} {
continue; # Skip READONLY entries which are NOT part of the main file
}

set keyword [sh_list keyword $i]; # get short form
set longform[sh_list text $i]; # get long form
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}

# insert a backslash in front of all double quotes
regsub -all {"} $keyword {\\"} keyword;
regsub -all {"} $longform{\\"} |ongform

# renove carriage return (ASCIlI code 13) characters fromlong form since
# the puts conmmand will automatically insert a carriage return

# before every linefeed (ASCI|I code 10) character

regsub -all {\r} $longform"" |ongform

# wite to file as conma-delinmted, double-quoted strings
puts $f "\"${keyword}\", \"$longform"";
i ncr count;

}

# close the file

cl ose $f;

# di splay user nmessage
sh_input nmsg "" "$count entries were witten to: $fil enanme";

# The following Iines work around this bug in Sh851 and earlier by
# redisplaying the main window if it is visible
if {[sh_wi ndow show] == 1} {

# we use "catch" to suppress focus error nessages

# whi ch could occur if you use W n95.

catch {sh_wi ndow show 1;}

}

return;

# run the proc

_print_dictionary;

rename _print_dictionary ; # renmpve proc from nenory.
return; # all done




Chapter 5 Tcl Scripts 117

How to run the script
There are two ways to run the script:

METHOD #1: From Shorthand's Shortcut Menu

1. Placethe sh_print_dictionary.tcl file in your Shorthand folder.

2. From Shorthand's Shortcut menu, choose Edit.

3. Click the Add button.

4. Click the Browse button and select the sh_print_dictionary.tcl file.

5. In the Specify a File Shortcut box, specify a keyboard shortcut (e.g. Shift+Ctrl+P)
6. In the Description box, type in a short description (e.g. "Print").

7. Click OK as necessary to return back to Shorthand main window.

8. You can now run the script by invoking the keyboard shortcut or by choosing "Print"
from Shorthand's Shortcut menu.

METHOD #2: From Shorthand's File Menu

1. From Shorthand's File menu, choose Tcl Script.
2. Click the Open button and load in the sh_print_dictionary.tcl file.
3. Click the Eval Script button.

How it works

The script starts by calling the sh_i nput save command to ask for the destination
filename from the user. The script then loops through every entry in the active
dictionary and callsthe sh_list keyword and sh_list text commandsto read the
short and long forms of each dictionary entry. The regsub command is used to insert a
backslash in front of every double quote. Before writing the long form to the text file,
the regsub command is called again to strip out carriage returns from the long form;
thisis necessary because, on the Windows platform, Tcl's put s command automatically
inserts a carriage return (ASCI1 code 13) character in front of every linefeed (ASCII
code 10) character.
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How to import text from a comma-delimited file

Thisis the opposite problem of the script in the previous section (p. 115). The example
script below shows how you can use Tcl to read a comma-delimited word list into a
Shorthand dictionary. The contents of comma-delimited file should look like:

"keyword", "this is the long form" [enTer]
"t1", "\"this long form is enclosed in double quotes\"" [enter]
"t2", "this long form has [enTer]

two lines"

@ WARNING: This script isintended for illustration purposes only. The script modifies
your dictionaries and can corrupt data if not used correctly. Back up your Shorthand
dictionaries before performing executing the script as you can easily mess up your word
listsif you make a mistake.

Create the Tcl script file

Create afilecalled sh_import_text.tcl with the following Tcl code (the file can aso be
downloaded from http://www.pcshorthand.com/book):

# Proc to search and replace {\"} with "{@EM DQ"

proc _renmoveDQ {s} {
set searchFor {\\"};
set replaceWth "{@EM DG ";
regsub -all $searchFor $s $replaceWth result;
return $result;

}

# Proc to search and replace "{@GREM DG with "
proc _restoreDQ {s} {
set searchFor "{@EM DG ";
set replaceWth {"};
regsub -all $searchFor $s $replaceWth result;
return $result;

}

# Proc to read an entry. Returns 1 if successful. Returns O at end-of-file.
proc _get_entry { file shortfornVar |ongformvar } ({

upvar $shortfornvar shortform

upvar $l ongformvar | ongform

set $shortform"";

set $longform"";

while {1} {

if {[gets $file line] < 0} {
return 0; # end-of-file (no nore entries)

}
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# tenporarily hide the \" codes in $line
set line [_renoveDQ $line];

# convert $line to alist with " as the separator
set s [split $line {"}];

# a valid line should have at |east 3 double-quotes (or split
#into at least 4 entries); we skip lines that are invalid
set n [llength $s];
if {$n >= 4} {

br eak;
}

}

# Short formis the second list entry
set shortform[lindex $s 1];
set shortform[_restoreDQ $shortforn]; # restore double quotes

# Long formis the 4th list entry
set longform[lindex $s 3];

# if $line contains 4 or nore doubl e-quotes, we have
# the conplete long form (long formis a single line)
if {$n > 4} {

# restore doubl e quotes and exit

set longform [ _restoreDQ $l ongforni;

return 1,
}
# CGet the nulti-line long formby reading |ines until
# we encounter the term nating doubl e-quote.
while {1} {

if {[gets $file line] < 0} {

br eak;
}

set line [_renoveDQ $line];
set i [string first {"} $line];
if {$i >= 0} {
set s [string range $line 0 [expr $i - 1]];
append longform"\r\n" $s;
br eak;
} else {
append longform"\r\n" $line;
}

}

# restore doubl e quotes and exit
set longform|[ _restoreDQ $l ongforni;
return 1,
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# This is the main proc
proc _inport_text {} {
# CGet input filenane
set infile [sh_input open "Select comma-delimted text file to inport"];

if {[string equal $infile "SH CANCEL"] == 1} {return 0};

# CGet output .spf filename

set spffile "[file rootnane $infile].spf";

set spffile [sh_input save "Enter destination Shorthand dictionary (you can
specify a new file)" $spffile];

if { [string equal $spffile "SH CANCEL"] == 1} {return 0};

# Make sure links are disabled (a bug in SH351 will display the

# Preferences dialog box if the links list is enpty; if this happens,
# just close the Preferences box by clicking OK

sh_set links O;

# open the input file
set f [open $infile r];

# Open the target .spf file
sh_file open $spffile;

# start the conversion
set i O;
while {1} {
set shortform™"";
set longform"";
set result [ _get_entry $f shortformlongform];
if {$result == 0} {
br eak;
}

# wite entry to dictionary
sh_list update $shortform $l ongf orm
incr i;

}

# display result
sh_i nput msg "Conversion Conpleted!" "$i entries have been inported"
return;

}

# run our script
_inport_text;

# renmove procs from nenory
rename _inport_text {}
rename _get_entry {}
rename _renoveDQ {}

rename _restoreDQ {}

return ;
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How to run the script

&

There are two ways to run the script:
METHOD #1: From Shorthand's Shortcut Menu

1. Placethe sh_import_text.tcl file in your Shorthand folder.

2. From Shorthand's Shortcut menu, choose Edit.

3. Click the Add button.

4. Click the Browse button and select the sh_import_text.tcl file.

5. In the Specify a File Shortcut box, specify a keyboard shortcut (e.g. Shift+Ctrl+l1)

6. In the Description box, type in a short description (e.g. "Import text").

7. Click OK as necessary to return back to Shorthand main window.

8. You can now run the script by invoking the keyboard shortcut or by choosing "Import
text" from Shorthand's Shortcut menu.

There's a bug in Shorthand 8.51 and earlier in that the Preferences window may appear
when you cal the sh_set 1inks command and your Dictionary links list is empty; if
the Preferences window appears, just click on CANCEL to close it and the script will
continue.

METHOD #2: From Shorthand's File Menu

1. From Shorthand's File menu, choose Tcl Script.
2. Click the Open button and load in the sh_export_text.tcl file.
3. Click the Eval Script button.

How it works

After calling the sh_i nput open and sh_i nput save commandsto get the input file
and destination Shorthand dictionary, the script callsthe _get _entry proc to read the
short and long forms from the input file. The _get _entry proc parses the input strings
by calling Tcl's spl it command (with the double quote character as the separator) to
split the input string into a list; the short form will be the second list element and the
long form will be the fourth list element. To prevent the spl it command from
processing double gquotes that are really part of the short and long forms, the _r enoveDQ
proc is used to temporarily replace every occurrence of the string \" to the string
"{@REM DQ}". The _restoreDQ procis used to restore the double quotes just before
exitingthe _get_entry proc. The sh_list update commandisfinaly called to add
the short and long forms to the active dictionary.
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How to search with pattern matching

The following script is an example of a Tcl script that performs a search with pattern
matching of the Text to Type field of each dictionary entry. When the search is
completed, Shorthand brings up the Windows WORDPAD application with alist of the
Keywords that contain the specified pattern. This script demonstrates how to use Tcl to:

Display a dialog box to fetch an input string from the user.

Loop through each dictionary entry to search for a particular string pattern using the
string mat ch command.

Writeto atext file.
Launch an external application (WORDPAD) to display the text file.

Create the Tcl script file

Create afile caled sh_pattern_match.tcl with the following Tcl code (the file can also
be downloaded from http://www.pcshorthand.com/book):

proc _run_pattern_match {} {
# display dial og boxes to get user input
while {1} {
set pattern [sh_input string "Enter pattern to search for" ""]
if {$pattern==""} {continue;}
if {$pattern=="SH CANCEL"} {return}

br eak

set outfile [sh_input save "Save results to" "search results.txt"]
if {$outfile=="SH CANCEL"} {return}
set f [open $outfile wW;

puts $f

"**%* Searching for: \"$pattern\"";

puts $f "*"

puts $f

puts $f "

" Keywor d";

#--- Loop through the dictionary
set count O;
set n [sh_list length];
for {set i 0} {$i < $n} {incr i} {
set s [sh_list text $i]; # get TEXT TO TYPE
if {[string match -nocase $pattern $s]} {
# wite keyword nane to file
puts $f "[sh_list keyword $i]";
i ncr count;

}
}

puts $f ""
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puts $f "*** Found: $count entries";
close $f; #close the file
run "WordpPad" "\"$outfile\""; # bring up the file in WrdPad

}

_run_pattern_match;

# The following |ines work around a display bug in Sh8.51 and earlier
if {[sh_wi ndow show] == 1} {
catch {sh_wi ndow show 1};

}

return ""

How to run the script
There are two ways to run the script:

METHOD #1: From Shorthand's Shortcut Menu

1. Placethe sh_pattern_match.tcl file in your Shorthand folder.

2. From Shorthand's Shortcut menu, choose Edit.

3. Click the Add button.

4. Click the Browse button and select sh_pattern_match.tcl.

5. In the Specify a File Shortcut box, specify a keyboard shortcut (e.g. Shift+Ctrl+S)

6. In the Description box, type in a short description (e.g. "Search").

7. Click OK as necessary to return back to Shorthand main window.

7. 'You can now run the script by invoking the keyboard shortcut or by choosing
Sear ch from Shorthand's Shortcut menu.

METHOD #2: From Shorthand's File Menu

1. From Shorthand's File menu, choose Tcl Script.
2. Click the Open button and load in sh_pattern_match.tcl.
3. Click the Eval Script button.

How it works

The script loops through every entry in the active dictionary and usesthe sh_li st text
command to get the long form. Thelong form is searched using Tcl's string mat ch
command which performs a pattern match of the entire long form. For example:

The search pattern "min*" will match entries whose text BEGINS WITH the string
"min” (e.g. "minimum”, "Minnesota).

The search pattern "*min*" will match entries whose text CONTAINS the string
"min" (e.g. "unminted”, "minimum", "vermin").

The search pattern "*min" will match entries whose text ENDS WITH the string
"min" (e.g. "vermin").

Y ou can get more information on the string mat ch command from any Tcl book or
from the Tcl documentation at http://www.scriptics.com.
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How to perform a global search and replace

The following script is an example of a complex Tcl script to perform a search and
replace of words in your dictionaries. The script displays a pick list of the dictionaries
that appear in your Dictionary tabs; you can select which file(s) to perform the search
and replace.

This script demonstrates how to use Tcl to:

Read the names of the dictionary tabs from the PAGES.CFG file in the Shorthand
program folder and display the filesin a pick list.

Display apick list of search options to the user.

Loop through each dictionary entry and use Tcl's regsub command to do a search
and replace.

@ WARNING: This script isintended for illustration purposes only. The script modifies
your dictionaries and can corrupt dataif not used correctly. Back up your Shorthand
dictionaries before performing executing the script as you can easily mess up your word
listsif you make a mistake.

Create the Tcl script file

Create afile caled sh_global _search.tcl with the following Tcl code (the file can also
be downloaded from http://www.pcshorthand.com/book):

# Proc that returns a list of filenanes shown in the Dictionary tabs
# on Shorthand' s Main W ndow.
# The nanes of the tabs are kept in the PAGES. CFG file
# in the Shorthand program fol der.
proc sh_readPagesCfg {} {
# fol der where PAGES.CFG is stored
set shCfgPath [sh_w ndow cfgdir];
# open PAGES. CFG
set f [open "${shCf gPat h} PAGES. CFG'];
set result ""
# Read contents of PAGES.CFG |line by line
while {[gets $f line] >= 0} {
# convert "\" to "/"
regsub -all {\\} $line "/" line;
# add pat hnane if necessary
if {[file dirnane $line] == "."} {
set |ine $shCf gPat h$li ne;
}

| append result $line;

return $result;
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# This proc does the search and repl ace
proc _search_replace {old _word new word text_var bWol eWwrdsOnly bCaseSensitive}
{

# use Tcl's regsub conmand to search and replace $word in $text_var

upvar $text_var text;

set bMatch O;

if {$bCaseSensitive! =1} {

set noCase "-nocase";
} else {
set noCase "-all";

}
i f {$bWhol eWordsOnl y==1} {
# replace $old word if it occurs at the start of $text
if {[regsub $noCase -all "${old_word}(?=\\W" $text $new word text]} {
set bMatch 1,
}

# replace $old word if it occurs at the end of $text

if {[regsub $noCase -all "(?=\\W${old word}" $text $new word text]} {
set bMatch 1,

}

# replace $old_word if it occurs inside $text

if {[regsub $noCase -all "(?=\\W${old word}(?=\\W" $text $new word text]}{
set bMatch 1,

}

} else {
set bMatch [regsub $noCase -all $ol d_word $text $new word text];

}
return $bMat ch;
}

proc _run_search {} {
#--- Get the nanmes of dictionaries in PAGES. CFG
set files [sh_readPagesCfg];

#--- Make sure active dictionary is in the |ist
set currentFilelndex [Isearch $files [sh_file]];
if {ScurrentFilelndex >= 0} {

set defaul t Sel ections $currentFil el ndex;
} else {

set files [linsert $files O [sh_file]];

set defaultSelections {0};

}

# Al ow user to select which files to search
set selections [sh_input list "Select input files" $files $defaul tSel ections];
if {$selections == "SH CANCEL"} return;

# renmove | eadi ng braces from $sel ecti ons (needed only for SH3.51 or earlier).

regsub "~{" $selections "" selections;

regsub "}$" $selections "" selections;

# create hex map

for {set i 0} {$i < 256} {incr i} {
set ¢ [format % $i];
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set hexMap($c) "[format \\x%®02X $i]";
}
# display dial og boxes to get user input
while {1} {
set searchFor [sh_input string "Enter word to search for" ""]
if {$searchFor==""} {continue;}
i f {$searchFor=="SH CANCEL"} {return}
br eak;
}
# convert $searchFor to hex string so regsub will search
# for the literal characters
set searchForHex "";
set n [string length $searchFor];
for {set i 0} {$i < $n} {incr i} {
set sear chFor Hex $sear chFor Hex$hexMap([string range $searchFor $i $i]);
}

set replaceWth [sh_input string "Enter replacenment string" ""];
if {$replaceWth=="SH CANCEL"} {return}
set sOptions [sh_input list "Select search options” {
"Whol e words only" "Case sensitive" "(leave this box checked)"} {0 1 2}];
if {$sOptions=="SH CANCEL"} {return};

#--- Set up the search options

# First renove | eading braces (needed only for SH8.51 or earlier).
regsub "A{" $sOptions "" sOptions;

regsub "}$" $sOptions "" sOptions;

set bCaseSensitive 0;

set bWhol eWwrdsOnly O;

if {[|search $sOptions "0"] >= 0} { set bwol eWrdsOly 1}

if {[Isearch $sOptions "1"] >= 0} { set bCaseSensitive 1}

#--- renenber current file
set currentFile [sh_file];
set result "";

#--- Loop through each dictionary
foreach i $selections {
set file [lindex $files $i];
# skip non-existent files
if { [file exists $file] == 0} {
| append result [list $file "(Error: cannot open file)"];
conti nue;

}

# open file
sh_file open $file;

# perform search and repl ace
set n [sh_list length];
set count O;
for {set i 0} {$i < $n} {incr i} {
if {[sh_list readonly $i]} {
continue; # Skip READONLY entries which are NOT part of the main file

}
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set s [sh_list text $i]; # get TEXT TO TYPE
if {[_search_repl ace $searchForHex $replaceWth s bWol eWwrdsOnly
bCaseSensitive]} {
sh_list text $i "$s"; # nodify TEXT TO TYPE
i ncr count;
}

}
| append result [list $file "Mdified $count entries"];

# reopen current file
sh_file open $currentFile;
return $result;

}

set result [_run_search];
if {[Ilength $result] > 0} {
sh_input nsg "Search and Replace Results" [join $result "\n"];

}

# There's a bug in Sh8.51 and earlier in that the Shorthand mai n w ndow
# remains mnimzed if you use the sh_input comand through
# the File | Tcl Scripts nmenu or Shortcut nenu. The follow ng |ines work
# around this bug by redisplaying the main window if it is visible
if {[sh_w ndow show] == 1} {

catch {sh_wi ndow show 1};

} nn

return ;




128 Shorthand How-to Guide

How to run the script
There are two ways to run the script:

METHOD #1: From Shorthand's Shortcut Menu

1. Placethe sh_global_search.tcl file in your Shorthand folder.

2. From Shorthand's Shortcut menu, choose Edit.

3. Click the Add button.

4. Click the Browse button and select sh_global_search.tcl.

5. In the Specify a File Shortcut box, specify a keyboard shortcut (e.g. Shift+Ctrl+F)
6. In the Description box, type in a short description (e.g. "Search/Replace”).

7. Click OK as necessary to return back to Shorthand main window.

8. You can now run the script by invoking the keyboard shortcut or by choosing
"Search/Replace” from Shorthand's Shortcut menu.

METHOD #2: From Shorthand's File Menu

1. From Shorthand's File menu, choose Tcl Script.
2. Click the Open button and load in sh_global _search.tcl.
3. Click the Eval Script button.

How it works

The script determines the dictionaries listed in the Dictionary tabs by reading the
PAGES.CFG file located in your Shorthand folder. (Shorthand stores the dictionary tab
names in PAGES.CFG.) Since the PAGES.CFG is updated only after Shorthand exits,
the script makes sure the active dictionary is always included in the list. The script then
usesthe sh_i nput |ist command to present the dictionary filesin apick list in which
the user can select which dictionary to search through. The search and replacement
strings are obtained from the user through sh_i nput string commands.

The actual search and replace makes use of Tcl's powerful regsub command. To be
able to search/replace for the special Tcl characters (e.g. braces, double quotes, brackets,
backslashes), the script first converts the strings to their hexadecimal values before
applying the regsub command on the strings.

Y ou can get more information on the regsub command from any Tcl book or from the
Tcl documentation at http://www.scriptics.com.
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Appendix A: Common Problems

Symptom Remedy
Shorthand is not expanding - Make sure AutoReplace is enabled (p. 51).
abbreviations. Shorthand may be waiting for input; make sure there is no Shorthand

dialog box visible (click on the HIDE button if the Main Window is
visible).

Make sure the abbreviation is in the active Shorthand dictionary.

Try using Shorthand with NOTEPAD; if Shorthand works with
NOTEPAD then Shorthand is working properly and a function in your
word processor (e.g. spell checking) may be interfering with Shorthand.
Another application may be conflicting with Shorthand. Disable all
programs that monitor keystrokes such as spell checkers, clipboard
utilities, mouse utilities (e.g. Power Toys) and built-in word expanders
like QuickCorrect in WordPerfect and AutoCorrect in Microsoft Word.
Your computer may have a virus; scan your system for viruses.

Shorthand is expanding text in spurts.

This is by design to give your word processor time to process the keystrokes
from Shorthand. You can change the delay (p. 52).

Shorthand is expanding text too slowly.

Try decreasing the delay between keystrokes (p. 52).

Another application may be interfering with Shorthand. Disable all
programs that monitor keystrokes such as spell checkers, clipboard
utilities, mouse utilities (e.g. Power Toys) and built-in word expanders
such AutoCorrect in Microsoft Word.

Expanded text is missing characters or
coming out in parTIAL caps.

Shorthand may be expanding text too fast for your word processor to keep
up. Try increasing the delay between keystrokes (p. 52).

Shorthand is expanding inside another
word.

This can occur with some wireless keyboards. Try reinstalling your wireless
keyboard drivers or switch to a regular keyboard.

After an expansion, all my keys come
out in UPPERCASE.

A SHIFT UP key command was lost; reset your keyboard by pressing and
releasing the SHIFT key on the left side of your keyboard. Shorthand may
be expanding text too fast for your word processor to keep up; try increasing
the delay between keystrokes (p. 52).

Simulation of keys in the Numeric
Keypad (e.g. {@KEY home} or
{@KEY pgup} are not coming out
correctly.

Make sure the NUMLOCK key on your keyboard is disabled.

Windows crashes when using
Shorthand.

Run Shorthand last; that is, run your word processor first then run
Shorthand. This fixes most memory errors.

Another application may be conflicting with Shorthand. Disable all
programs that monitor keystrokes such as spell checkers, clipboard
utilities, mouse utilities (e.g. Power Toys) and built-in word expanders
like QuickCorrect in WordPerfect and AutoCorrect in Microsoft Word.
Your computer may have a virus; scan your system for viruses.
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Appendix B: Choosing the Right Keyword

Choosing the right keywords (abbreviations) can make you work much more efficiently;
agood keyword is short, easy to remember and does not conflict with real words.

Create special keywords to prevent unwanted expansions

Shorthand treats all non-al phanumeric characters as word separators so a common
problem is unwanted expansions in words with embedded punctuation marks. For
example, let’s say you have the following Shorthand entry:

t = the
Now if you type don’ t in your word processor, Shorthand will expand the “t” and you
will end up with: donthe
To prevent this, define another entry:
‘b=t
The above entry tells Shorthand to expand ‘t to ‘t. It may seem strange to define an

abbreviation that expands to itself but you can use thistrick to prevent unwanted
expansions.

An even better solution would be define an abbreviation for “don’t” so you don't have to
type the apostrophe at al:
dont = don’t

Avoid keywords with embedded punctuation marks

Another common problem is having abbreviations that contain punctuation marks. For
example, if you have these 2 entries:

t = the

t/o = take out
In your word processor, if you type: “t/0”, you will get: thelo
To fix this problem, define this additional entry to prevent Shorthand from expanding
“t/” to “the/”:

t/ =t/
A better solution would be avoid defining abbreviations with an embedded “/” (or any
punctuation marks). For example, you could define an entry for “take out” as:

t90 = take out
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Appendix C: Tips for Touch Typists

Below are some tips on controlling Shorthand entirely through the keyboard:

Use Shorthand's keyboard commands

Shorthand has a keyboard command to access most of its functions. The F10 (the Hot
key, p. 49) brings up the Main Window with Dictionary list box automatically scrolling
to the keyword closest to the word you last typed in your word processor. In Shorthand's
Main Window, you can press I ns to create a new dictionary entry or use your keyboard's
arrow keysto scroll up and down the dictionary list; you can also type the abbreviation
in the Keyword box to quickly jump to that entry. Press F2to edit or Alt+Insto
duplicate the selected entry in the Dictionary list box. When done, press Esc to hide the
Main Window and return to your word processor.

Disable the Description box tab stop

It is not necessary to enter something in the Description box when adding a dictionary
entry. By default, when you press the Tab key in the Text to Type box, your cursor will
move to the Description box and you have press Tab again to move to the OK button.

Y ou can make the Tab key skip over the Description box and go directly to OK button;
here's how to do this:

1. Bring up the Dictionary Text window by modifying any entry (see p. 34).

2. Position your mouse over the Description box and click your right mouse button. A
pop-up menu appears.

3. If thereisacheck mark next to the Enable Tabstop option in the pop-up menu,
deselect (uncheck) it by clicking on the Enable Tabstop option in the pop-up menu.

Use the Alt+Ins key to add new entries
Let’s say you have launched Shorthand (p. 13) and are typing a letter in your word
processor. Y ou want to add an entry for “Sincerely yours,” in Shorthand. To do this:

1. Press Alt+Ins (p. 55) to create a new entry in Shorthand. Shorthand displays an
empty Dictionary Text [Add] dialog box with your text cursor blinking in the
Keyword box (p. 27).

2. Inthe Keyword box, type in your abbreviation (e.g. “sy”) then pressthe Tab key.
Y our text cursor is now blinking in the Text to Type box (p. 30).

3. Inthe Text to Type box, type in your long form (e.g. “ Sincerely yours,”) and press
the Tab key. The OK button should be selected (i.e. a dotted rectangle around it).

4. PressEnter to save your entry and return to your word processor.



132

Shorthand How-to Guide

Appendix D: Windows Keyboard Shortcuts

Shorthand can only simulate keystrokes. Fortunately, Windows is designed such that you can access
almost any Windows function through a keyboard command. The following table lists some

common functions and their keyboard commands:

{@KEY} code Function

{ @KEY al t +t ab} Activate next window.

{ @XEY t ab} Moves cursor to the next field in a window.

{ @XEY al t +space} Activates the application's main window's system menu (e.g. to
minimize or maximize the window).

{@XEY alt+ -} Activates the current window's system menu.

{ @EY ctrl +esc} Activates the Windows START menu.

{ @EY shift+right} Selects text; normally used with Ctrl+C to copy text to the clipboard.

{@KEY shift+left}

{ @EY shi ft +up}

{ @XEY shi ft +down}

{ @XEY shi ft+hone}

{ @EY shi ft +end}

{@EY ctrl +c} Copies selected text to the clipboard.

{@EY ctrl +i ns}

{@EY ctrl +v} Pastes clipboard text.

{ @XEY shi ft+ins}

{ @XEY hone} Moves cursor to the beginning or end of the text line.

{ @XEY end}

{ @XEY ctrl +hone} Moves cursor to the beginning or end of the text.

{ @EY ctrl +end}

{@KEY ctrl +l eft} Moves cursor one word left or right.

{@EY ctrl +right}

@ Notes

After the { @KEY} command to switch or open a new window or menu, you may
need to use the { @PAUSE} tag (p.72) to give time for Windows to redraw the

screen.

Word processors (such as Microsoft Word and WordPerfect) have keyboard
shortcuts for al their important functions (e.g. change to bold or superscript). If you
know the keyboard command, you can simulate the function with Shorthand's

{@KEY} tag (see p. 70 for an example).
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Appendix E: How to move Shorthand to another
computer

To move your Shorthand files to a new computer:
1. Install Shorthand on the new PC.
2. Onyour old PC, locate your Shorthand folder (see p. 10).

3. Copy the following files from your Shorthand folder to a floppy disk (you may need
more than one floppy disk if your word lists are large):
PAGES. CFG
HI STORY. CFG
SHORTHND. | NI
SHY. LI C
SHORTHND. TCL
SH7SPELL. UDT

Also copy al your Shorthand dictionary (*.SPF) filesto the floppy disk. Note: if
you saved your word list (*.SPF) files to a different folder, you will need to locate
and copy those .SPF files to the floppy disk also.

4. Make sure Shorthand is not running on your new PC.
5. Insert the floppy disk you made in step 3 to your new PC.

6. Copy the contents of the floppy disk to your Shorthand folder (see p. 10) on the new
PC.

7. Start Shorthand on your new PC. Shorthand should pick up your saved settings.
However, if you moved your word lists to a folder on your new PC that has a
different name or hard drive letter than what was on your old PC, Shorthand may
display a message saying it was unable to find afile. If thisisthe case, you can
reopen the file by choosing Open from the File menu.

It is recommended that you DO NOT DELETE any of your files from your old PC until
you are certain that you moved al your files and Shorthand works properly on your new
PC.

@ Your Shorthand folder can be determined from the
Preferences window's title bar.

Bring up the Preferences window by choosing Preferences

from Shorthand's File menu. The title bar of the Preferences

window shows the path to the SHORTHND.INI file where your

preferences are saved. The folder where you find the

SHORTHND.INI file is your Shorthand folder.
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@DELETELINE, 67, 86
@INPUT, 67, 76, 78
@INPUTDATE, 66, 67, 75
@INPUTFILE, 67, 82
@INPUTMSG, 67
@INPUTTCL, 67, 89, 96
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@KEYDOWN, 66

@KEY UP, 66
@LEFTBRACE, 67, 88
@LONGDATE, 66, 74
@LONGTIME, 66
@NOSPACE, 67, 85
@PAUSE, 66, 72

@REM, 67
@RIGHTBRACE, 67, 88
@SHORTDATE, 66
@SHORTTIME, 66, 74

A

Abbreviations. See Keywords
Arithmetic computations, 102
Automatic file saving, 62
Automatic Keyword Completion, 59
AutoReplace, 51

controlling from Tcl, 104

B

Backup dictionaries, 19
C

Common problems, 129
D

Date and time, 74, 75

Dictionary, 8

adding new entries, 24, 131
automatic saving, 62
backup, 19

copying entries, 38
creating, 18

deleting entries, 26
duplicating entries, 36
editing entries, 34

linking, 40

modifying entries, 34
opening, 20
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opening with asingle keystroke, 48

print to file, 21, 115

protecting, 46

renaming, 22

saving, 19

search and replace, 124

searching, 39, 122
Dictionary File Tabs, 17

removing, 45

E

Expansion speed, 52, 72
Extralines, preventing, 86
Extra spaces, preventing, 85

F

File Converter Utility, 7
File Shortcut, 8, 42
Files. See also Dictionary
copying, 11
deleting, 11
inserting in Shorthand, 82
removing, 23
renaming, 11, 23
using @KEY to open, 84
Fonts
Shorthand options, 61
using @KEY to change, 70

H

Hint Window, 58
Hot Key, 9, 49

K
Keyboard shortcuts, 9, 132

Keyboard simulation, 68, 70, 71, 72, 132

Tcl, 99
Keystroke Recorder, 32
Keyword Shortcut, 9
Keywords, 9, 27
preventing expansion, 48
shortcuts, 28

L

Launching applications. See
applications

Running external



Addendum

License File, 10

License ID, 47

Linking dictionaries, 9, 40
Long forms. See Text toType

M

Main Window, 13, 14
Merging dictionaries, 40
Microsoft Word
conflicts with AutoCorrect, 129
converting AutoCorrect, 7

N
Network, using Shorthand on a, 64

P

Pick lists, 78
PRD+, 7
Print to file, 21, 115

R

Recording keystrokes, 32

Registration ID, 47

Replay expansion, 48

Running external applications, 48
Tcl, 93,98

S

Search and replace, 124
Searching, 122
SHI.LIC, 10

SHCNV.EXE. See File Converter Utility

Short forms. See Keywords
Shorthand

audible feedback, 60

changing display fonts and size, 61

exit confirmation, 63

folder, 10, 133

hot key, 49

icon, 9

Licensefile, 10

main window. See Main Window

moving to ancther computer, 133

pausing, 72

sharing on a network, 64

speed, 52

starting, 13

window colors, 61
SHORTHND.TCL file, 95
Sound options, 60
Special characters

using @KEY to simulate, 71
Suggestion Window, 10, 56, 106
System Tray, 10

T

Tags, 11, 65
date and time, 66, 74
date input, 75
entering left and right braces, 88
getting input from user, 76
input, 67
keyboard simulation, 66, 68, 70, 71
pick lists, 78
reading files, 67
Tcl scripts, 89
variables, 11, 87
Tcl, 11
@INPUTTCL, 96
arithmetic computations, 102
autoreplace, 104
getting input from user, 92, 112
introduction, 89
keyboard simulation, 99
official web site, 91
pausing, 108
programming guidelines, 92
reading dictionary text, 100
resources, 91
running external applications, 93, 98
search and replace, 124
searching, 122
SHORTHND.TCL file, 95
suggestion window, 106
Text to Type, 11, 30
Text to Type box, 12
line counter, 31
recording keystrokes, 32
Text transfer methods, 54
Tutorials, 6

U
User ID, 47

V
Variables, 11

W

Windows
keyboard shortcuts, 132
START button, 10, 13
system tray, 10
Windows Explorer, 11, 23
WordPerfect, 129
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Quick Guide to Common Questions

How do | start Shorthand? See p. 13.

How do | know if Shorthand isrunning? The Shorthand icon appearsin the
Windows System Tray when Shorthand is running (p. 13).

How do | simulate special fonts such as bold and super scripts? Use Shorthand's
@KEY tag to simulate your word processor's keyboard command to switch fonts

(p. 70).

How do I make Shorthand pause to accept input? Use Shorthand's @INPUT tag
to get input from the user (p. 76).

How do I move Shorthand to a new computer? See p. 133.
How do | create a new, empty word list? Choose File= New (p. 18).

How do | remove a dictionary tab from Shorthand? Choose File = Close
(p. 45).

How do | merge two or mor e separ ate dictionariesinto one big one? You merge
dictionaries by linking them together (p. 40).

Whereismy Shorthand USER 1D and LICENSE 1D? Choose Help = About
(p. 47).

Whereisthe Shorthand folder? The Shorthand folder is where the SH9.EXE
program is located (p. 133).

Why doesn't the text from Shorthand come out in upper case even though the
CAPSLOCK keyison? CAPSLOCK affects expanded text only if you set the
Text Transfer method to "Simulate Keystrokes' (p.54).

After an expansion, why are the characters| type coming out in UPPERCASE
even though | don't pressthe SHIFT key? Your word processor dropped a
SHIFT UP command from Shorthand (see p. 129 row 4). Fix this by slowing down
Shorthand (p. 52). A setting of Pause 20 msec every 1 keystrokes should work with
most computers.



